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BlaupunktCCR-890
Device Note 06.09.95

Typ:
System: Hi8
TV Standard: PAL
Remote: LAN-C/Control L
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings at
machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
Zeichnet RCTC auf, gibt ihn aber nicht wieder.
Bei TC Test
Error 87 "VITC reading not enabled for this player.
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Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS
DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE.
THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES
AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

BlaupunktRTV-830
Device Note 06.09.95

Typ:
System: VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
None
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Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE
IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS.
FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN.
EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES
NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT
RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE
CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION
PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY
AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON
SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

BlaupunktRTV-846 HiFi
Device Note 06.09.95

Typ:
System: VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
At front EDITING CONTROL EDIT (RECORDER)

Kommentar:

Connectors:

Ort Connector Out (wenn vorhanden) Connect to (In)
At front Video in, Audio 1+2 in, ,

Sicherungszapfen und modifizierter Nut
zum Positionieren.

Backside 2 x Scart + Audio 1 + 2 VM composite out or SC Box ref out

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings at
machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/656780f6e827c556c125622f005e2e9b?OpenDocument&ExpandSection=-1#_Section1
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Tips und Tricks/ Trouble shooting:
Edit.control Level 3

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED
"AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY,
WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE,
OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS
DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS
NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT
OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS
DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS
WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND
THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/656780f6e827c556c125622f005e2e9b?OpenDocument&ExpandSection=-5#_Section5


 

BlaupunktRTV-915
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
At front Input Select S-Video

Kommentar: nothing special

Connectors:

Kommentar: nothing special

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
no software settings

EintragNr. Eintrag Einstellungen
1 channel AV (visible at display)

Standard Einstellungen für Treiber/ Default settings for driver:
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Tips und Tricks/ Trouble shooting:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE
IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS.
FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN.
EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES
NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT
RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE
CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION
PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY
AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON
SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1ba264f1c690d95fc125622f0062b60a?OpenDocument&ExpandSection=-5#_Section5


 

BlaupunktRTV-925 EGC
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
None
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Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE
IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS.
FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN.
EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES
NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT
RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE
CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION
PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY
AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON
SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

BlaupunktRTV-950
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
Alte Werte vom 1.7.93(!) :
Play start pos. 9
Play prestart time 0
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Rec start pos. 348
Rec prestart time 402
Edit off delay 4
Audio dub start pos. 200

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE
IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS.
FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN.
EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES
NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT
RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE
CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION
PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY
AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON
SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

BlaupunktSCR-750
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:
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Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/646a2ef346218437c125622f005fce10?OpenDocument&ExpandSection=-5#_Section5


REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Video Machine - Device Notes

Blaupunkt
Canon

EX-1
UC-X2 Hi
XL 1

JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix

[
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Video Machine - Device Notes

Blaupunkt
Canon
JVC

BR-D50E
BR-D85E
BR-S 605 EB
BR-S368
BR-S500E
BR-S525E
BR-S800E
BR-S811E/SA-F911E
BR-S822E
KR-M840EA
KR-M860EA

Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix

[
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi

HS-E82 PC VCR
HS-M1000(G)

Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari

DTR-90
Panasonic
RICOH
Sanyo
Sony
Tektronix

[
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic

AG-1970
AG-1980P
AG-455P
AG-4700
AG-5700
AG-7150
AG-7350
AG-7355E
AG-7600E
AG-7700E
AG-7750E
AG-8600E
AG-8700E
AJ-D350
AJ-D580
AJ-D650
AJ-D750
AU-65H
AU-W35R
NV-F 77EG
NV-FS 200
NV-FS 200 PC
NV-FS 88EG
NV-FS 90
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH

R-18H
Sanyo
Sony
Tektronix
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo

GVR-S955
GVR-S960

Sony
Tektronix

[
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony

BVU-870P
BVW-15P
BVW-40P
BVW-60P
BVW-65P
BVW-70P
BVW-75P
BVW-95P
BVW-96P
CCD-FX 400E
CCD-FX 700E
CCD-TR 2000E
CCD-TR 323
CCD-TR 750E
CCD-TR 808 E
CCD-VX 3
CVD-1000
DCR-PC7E
DCR-VX1000E
DCR-VX9000E
DHR-1000VC

[
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix

PDR 100 Video Disk Recorder (Profile)
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Video Machine - Device Notes

Tektronix
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix
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Canon EX-1
Device Note 06.09.95

Typ:
System: Hi8
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings at
machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
None

Disclaimer:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/99a0124757f298f0c125622f00600770?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/99a0124757f298f0c125622f00600770?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/99a0124757f298f0c125622f00600770?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/99a0124757f298f0c125622f00600770?OpenDocument&ExpandSection=-4#_Section4
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/99a0124757f298f0c125622f00600770?OpenDocument&ExpandSection=-5#_Section5


FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS
DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE.
THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES
AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Canon UC-X2 Hi
Device Note 10.05.96

Typ:
System: Hi8
TV Standard: PAL
Remote: LAN-C/Control L
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

Top hidden Menue Edit ON

Kommentar: Set camera control switch to PLAY before setting menue to EDIT ON

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Rear Video + Audio out VM IN

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4db436edd75573cac125632600564fcf?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4db436edd75573cac125632600564fcf?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4db436edd75573cac125632600564fcf?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4db436edd75573cac125632600564fcf?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
The MENUE button at the top has to be switched to EDIT ON again, after the camera is switched off
once

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4db436edd75573cac125632600564fcf?OpenDocument&ExpandSection=-5#_Section5




 

Canon XL 1
Device Note 21.07.98

Typ:
System: Mini DV
TV Standard: PAL
Remote: LAN-C/Control L
Treiber: LANCRCTC.VMP
FreigabeDatum: 20.01.98

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
Camera is up to 5 frames inaccurate.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/61227eddf6490191412566480040597d?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/61227eddf6490191412566480040597d?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/61227eddf6490191412566480040597d?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/61227eddf6490191412566480040597d?OpenDocument&ExpandSection=-4#_Section4
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/61227eddf6490191412566480040597d?OpenDocument&ExpandSection=-5#_Section5


Tested under WIN 98

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Video Machine - Device Notes

Tektronix
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix
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http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=10&Count=30&Collapse=3#3


JVC BR-D50E
Device Note 24.03.97

Typ:
System: Digital S
TV Standard: PAL
Remote: RS 422
Treiber: SONYBC.VMP
FreigabeDatum: 17.01.97

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front COUNTER TC
At front REMOTE 9PIN

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the SET and SELECT button when the
SETUP-MENU is at menu entree "00C USER PAGE".

EintragNr. Eintrag Einstellungen
317 9PIN DEVICE ID OTHER TYPE 2
5 Auto Tracking OFF-->Preroll 5sec; ON --->Preroll

7sec

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/5324be51d1db47adc125646400420aad?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/5324be51d1db47adc125646400420aad?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/5324be51d1db47adc125646400420aad?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/5324be51d1db47adc125646400420aad?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
- Pay attention that in the setup menu of the device CHARA V POSITION of SCREEN DISPLAY is on the
bottom. Otherwise you will have a field delay.
- If you work with slow motion we cannot guarantee that it works fine, as the VCR itself at the moment
works only correctly with -32 to +32 speed.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/5324be51d1db47adc125646400420aad?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



JVC BR-D85E
Device Note 25.03.97

Typ:
System: Digital S
TV Standard: PAL
Remote: RS 422
Treiber: SONYBC.VMP
FreigabeDatum: 17.01.97

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front TIME CODE INT
At front TIME CODE REC
At front TIME CODE REGEN
At front AUDIO INPUT ANA
At front COUNTER TC
At front REMOTE 9PIN
At front VIDEO INPUT LINE / CPN

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the SET and SELECT button when the
SETUP-MENU is at menu entree "00C USER PAGE".

EintragNr. Eintrag Einstellungen
5 Auto Tracking OFF--->Preroll 5sec ON--->Preroll

7sec
317 9PIN DEVICE ID OTHER TYPE 2
351 PREREAD OFF

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4ee3c2ce4776c484c12564650046a23d?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4ee3c2ce4776c484c12564650046a23d?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4ee3c2ce4776c484c12564650046a23d?OpenDocument&ExpandSection=-3#_Section3


 

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4ee3c2ce4776c484c12564650046a23d?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
- Pay attention that in the setup menu of the device CHARA V POSITION of SCREEN DISPLAY is on the
bottom. Otherwise you will have a field delay.
- If you work with slow motion we cannot guarantee that it works fine, as the VCR itself at the moment
works only correctly with -32 to +32 speed.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4ee3c2ce4776c484c12564650046a23d?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

JVC BR-S 605 EB
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 232
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
At front SYNC SELECT EXT

Kommentar:

Connectors:

Ort Connector Out (wenn vorhanden) Connect to (In)
Backside sync in Ref-out or composite-out

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

EintragNr. Eintrag Einstellungen
0 Color Frame Servo ON Recorder
43 LTC OFF
72 OFF

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ec1e594a26af0877c125622f005bf5ff?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ec1e594a26af0877c125622f005bf5ff?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ec1e594a26af0877c125622f005bf5ff?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ec1e594a26af0877c125622f005bf5ff?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
It is not possible to do audio dub
If you want to do a First Edit, you have to dissable "Use CTL-TC Board" in the Device Setup.
Sometimes it may happen that a preview is only black--->plug off power supply of BR-S 605 and plug in once
again.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST
MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH
CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE
FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF
WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN
THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION
OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED
WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY
PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG
AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ec1e594a26af0877c125622f005bf5ff?OpenDocument&ExpandSection=-5#_Section5


© Copyright FAST Multimedia AG. All rights reserved.



 

JVC BR-S368
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 232
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e0f976e69db73cddc125622f005bb539?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e0f976e69db73cddc125622f005bb539?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e0f976e69db73cddc125622f005bb539?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e0f976e69db73cddc125622f005bb539?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST
MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH
CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE
FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF
WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN
THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION
OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED
WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY
PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG
AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e0f976e69db73cddc125622f005bb539?OpenDocument&ExpandSection=-5#_Section5


JVC BR-S500E
Device Note 22.07.97

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front REMOTE REMOTE
At front COUNTER TIMECODE
Backside TIMER OFF

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:

EintragNr. Eintrag Einstellungen
0 FRAME SERVO 2 FIELD (PLAYER)
3 SYNC SELECT EXTERNAL
206 AUD-2/LTC LTC

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/9f8cbe52065fb8cf412564dc0057310b?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/9f8cbe52065fb8cf412564dc0057310b?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/9f8cbe52065fb8cf412564dc0057310b?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/9f8cbe52065fb8cf412564dc0057310b?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
Use the VTR only with SA-R50E LTC/VITC (EBU) time code reader and SA-K26E 9-pin interface board.
The VTR are tested only with internal TC.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/9f8cbe52065fb8cf412564dc0057310b?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



JVC BR-S525E
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL / NTSC
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
At front REC MODE CONTINUE
Under front hidden AGC ON

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside Ref video Ref out or Composite out

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU
is indicated.

EintragNr. Eintrag Einstellungen
317 9P DEVICE TYPE SELECT OTHER TYPE 2
320 PREROLL TIME 7 SEC
333 CF SERVO LOCK ENABLE
601 V BLANK MASK OFF

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d592afe2e3b2e0dac125622f005c8343?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d592afe2e3b2e0dac125622f005c8343?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d592afe2e3b2e0dac125622f005c8343?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d592afe2e3b2e0dac125622f005c8343?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d592afe2e3b2e0dac125622f005c8343?OpenDocument&ExpandSection=-5#_Section5


TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION
CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS
DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE
EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR
IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE
USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED
ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



JVC BR-S800E
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.
319 Video EDIT DELAY 8FRAMES
320 AUDIO EDIT DELAY 8FRAMES
414 TCG SELECT Regen; for 1st-Edit Preset

EintragNr. Eintrag Einstellungen
0 FRAME SERVO 2 FIELD (PLAYER), 4 FIELD

(RECORDER)
3 SYNC SELECT EXTERNAL
101 EDIT SELECT ENHANCED
206 AUD-2/LTC LTC
317 9PIN DEVICE ID OTHER TYPE 2

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3773f2c5f12f18e4c125622f005dafc8?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3773f2c5f12f18e4c125622f005dafc8?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3773f2c5f12f18e4c125622f005dafc8?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3773f2c5f12f18e4c125622f005dafc8?OpenDocument&ExpandSection=-4#_Section4


 





Tips und Tricks/ Trouble shooting:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3773f2c5f12f18e4c125622f005dafc8?OpenDocument&ExpandSection=-5#_Section5




JVC BR-S811E/SA-F911E
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL NTSC
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front MODE PAY (PLAYER)
Under front hidden SYNC SELECT INT
Backside VIDEO IN 75 Ohm ON

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside ref in VM composite out or SC Box ref
out

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
Besitzt kein SW setup!

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f4c06dc0dd265d72c125622f005defce?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f4c06dc0dd265d72c125622f005defce?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f4c06dc0dd265d72c125622f005defce?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f4c06dc0dd265d72c125622f005defce?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
Running the device without TC board:
Switch off TC-board-available. Select appropriate switches inVM TC setup-box if desired.

Running the device in CTL Mode with TC board installed:
Switch off LTC and VITC, Leave TC-board-available checked.

FAST is not able to fully recommend this device configuration with interface, due to the fact that it doesn´t
support
the complete sony protocol instruction set. .

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f4c06dc0dd265d72c125622f005defce?OpenDocument&ExpandSection=-5#_Section5


ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



JVC BR-S822E
Device Note 07.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar: If vcr is used as recorder, during recording set tc settings to INT/REGEN/REC.

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
0 FRAME SERVO 2 FIELD (PLAYER), 4 FIELD

(RECORDER)
317 9P DEVICE TYPE SELECT OTHER TYPE 2
318 TC DATA W/O TC BOARD CTL DATA
323 MODE AFTER PREROLL STILL
353 SYNC GRADE ACCURATE

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/55ec8eadad23cdb3c1256230002fb124?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/55ec8eadad23cdb3c1256230002fb124?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/55ec8eadad23cdb3c1256230002fb124?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/55ec8eadad23cdb3c1256230002fb124?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
TC board and TBC are optional

Further important adjustments in the software of the device:
206 Audio2 LTC
402 CTL drop frame Non drop
407 Phase Correction bit ON

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/55ec8eadad23cdb3c1256230002fb124?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

JVC KR-M840EA
Device Note 06.09.95

Typ:
System: MII
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/fbad60bd7836ab8cc125622f00647ffb?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/fbad60bd7836ab8cc125622f00647ffb?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/fbad60bd7836ab8cc125622f00647ffb?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/fbad60bd7836ab8cc125622f00647ffb?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/fbad60bd7836ab8cc125622f00647ffb?OpenDocument&ExpandSection=-5#_Section5


WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

JVC KR-M860EA
Device Note 06.09.95

Typ:
System: MII
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1983a27fb3155640c125622f0064551d?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1983a27fb3155640c125622f0064551d?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1983a27fb3155640c125622f0064551d?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1983a27fb3155640c125622f0064551d?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1983a27fb3155640c125622f0064551d?OpenDocument&ExpandSection=-5#_Section5


WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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© Copyright FAST Multimedia AG. All rights reserved.



Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix
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© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=10&Count=30&Collapse=4#4


 

MitsubishiHS-E82 PC VCR
Device Note 07.09.95

Typ:
System:
TV Standard:
Remote:
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7dbb7f2fe10737d8c125623000313f7a?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7dbb7f2fe10737d8c125623000313f7a?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7dbb7f2fe10737d8c125623000313f7a?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7dbb7f2fe10737d8c125623000313f7a?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7dbb7f2fe10737d8c125623000313f7a?OpenDocument&ExpandSection=-5#_Section5


ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

MitsubishiHS-M1000(G)
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 232
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front LP/SP SP
At front Fernb VCR A
At front Programm L2

Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/25d42542d15adda3c125622f005c243b?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/25d42542d15adda3c125622f005c243b?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/25d42542d15adda3c125622f005c243b?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/25d42542d15adda3c125622f005c243b?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
With this device there is just video only or audio only insert possible. If you want to perform a video/audio
insert, the device
will insert video only

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/25d42542d15adda3c125622f005c243b?OpenDocument&ExpandSection=-5#_Section5


ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Video Machine - Device Notes

Tektronix

[

 Previous Page | Next Page 

<br>]

© Copyright FAST Multimedia AG. All rights reserved.



Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix

[

 Previous Page | Next Page 

<br>]

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=10&Count=30&Collapse=5#5


Otari DTR-90
Device Note 06.09.95

Typ:
System: DAT
TV Standard:
Remote: RS 422 9p
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside Ref video Ref out or composite out or YUV
ref out

Kommentar: Software setup on device, different from default.

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU
is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0f589a745e85e0dac125622f005cef9c?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0f589a745e85e0dac125622f005cef9c?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0f589a745e85e0dac125622f005cef9c?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0f589a745e85e0dac125622f005cef9c?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:
Enable "sloppy TC implementation in protocol"
TC reader / generator optional equipment,
Memora start option enables frame accurate editing in jog/shuttle mode.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0f589a745e85e0dac125622f005cef9c?OpenDocument&ExpandSection=-5#_Section5


When choosing this device, you get a prompt, that says:
Switch Audio2 off for editing.
No TC-dub possible.
RESET unstbale during editing delay.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION
CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS
DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE
EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR
IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE
USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED
ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Video Machine - Device Notes

Tektronix
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<br>]

© Copyright FAST Multimedia AG. All rights reserved.



Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix

[

 Previous Page | Next Page 

<br>]

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=10&Count=30&Collapse=6#6


 

PanasonicAG-1970
Device Note 06.09.95

Typ:
System:
TV Standard: NTSC
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f93b80af869ba795c125622f005e8431?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f93b80af869ba795c125622f005e8431?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f93b80af869ba795c125622f005e8431?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f93b80af869ba795c125622f005e8431?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f93b80af869ba795c125622f005e8431?OpenDocument&ExpandSection=-5#_Section5


 

PanasonicAG-1980P
Device Note 09.04.96

Typ:
System: S-VHS
TV Standard: NTSC
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e6023331cd450192c1256307004a7285?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e6023331cd450192c1256307004a7285?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e6023331cd450192c1256307004a7285?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e6023331cd450192c1256307004a7285?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e6023331cd450192c1256307004a7285?OpenDocument&ExpandSection=-5#_Section5


 

PanasonicAG-455P
Device Note 07.09.95

Typ:
System: S-VHS
TV Standard: NTSC
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/a4e0e7b76293619ac1256230004f8346?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/a4e0e7b76293619ac1256230004f8346?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/a4e0e7b76293619ac1256230004f8346?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/a4e0e7b76293619ac1256230004f8346?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/a4e0e7b76293619ac1256230004f8346?OpenDocument&ExpandSection=-5#_Section5


TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAG-4700
Device Note 07.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
At front EDIT MODE PASSIVE

Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/b04f57fda153cd39c1256230004ddf75?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/b04f57fda153cd39c1256230004ddf75?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/b04f57fda153cd39c1256230004ddf75?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/b04f57fda153cd39c1256230004ddf75?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE
IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS.
FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/b04f57fda153cd39c1256230004ddf75?OpenDocument&ExpandSection=-5#_Section5


ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN.
EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES
NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT
RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE
CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION
PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY
AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON
SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

PanasonicAG-5700
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 232
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
Backside MODE LOCK OFF

Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU
is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c8a5b28c272b39efc125622f005f3dab?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c8a5b28c272b39efc125622f005f3dab?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c8a5b28c272b39efc125622f005f3dab?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c8a5b28c272b39efc125622f005f3dab?OpenDocument&ExpandSection=-4#_Section4


AG-5700 = Rekorder

Tips und Tricks/ Trouble shooting:
As recorder the device is not able to perform a goto

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE
IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS.
FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN.
EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES
NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT
RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE
CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION
PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY
AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c8a5b28c272b39efc125622f005f3dab?OpenDocument&ExpandSection=-5#_Section5


ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAG-7150
Device Note 04.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 232
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

Under front hidden TV SYSTEM PAL

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
Running the device without TC board:
Switch off "TC board available"
Select appropriate switches in VM TC setup box if desired.

Running the device in CTL mode with TC board installed:
Swith off LTC and VITC. Leave "TC board available" checked.

To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ed20c7b70d6f4dfec125622d005f71b4?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ed20c7b70d6f4dfec125622d005f71b4?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ed20c7b70d6f4dfec125622d005f71b4?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ed20c7b70d6f4dfec125622d005f71b4?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:
The machine can't read VITC when using VM VITC.
Switch the TBC control selector on the front to bypass.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ed20c7b70d6f4dfec125622d005f71b4?OpenDocument&ExpandSection=-5#_Section5


CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAG-7350
Device Note 06.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 232
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

Under front hidden AGC ON

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside ref video ref out or composite out or YUV
ref out

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/aafa4934d2ca6fbbc125622f005d81de?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/aafa4934d2ca6fbbc125622f005d81de?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/aafa4934d2ca6fbbc125622f005d81de?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/aafa4934d2ca6fbbc125622f005d81de?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:
Assemble only device
No first-edit function
Rec-preview only with video-insert-only mode
(Rec-preview is only possible in V-insert-only mode, not meanwhile recording.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/aafa4934d2ca6fbbc125622f005d81de?OpenDocument&ExpandSection=-5#_Section5


PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAG-7355E
Device Note 07.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 232
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

Under front hidden MODE LOCK OFF
Backside DIB1/SW1 = BIT LENGTH OFF = 7 BIT
Backside DIB1/SW2 = STOP BIT OFF = STOP 1
Backside DIB1/SW3 = PARITY OFF = ODD
Backside DIB1/SW4 = PARITY OFF = ODD
Backside DIB1/SW5 = BAUD RATE OFF = 9600
Backside DIB1/SW6 = BAUD RATE ON = 9600
Backside DIB2/SW1-5 OFF
Backside DIB2/SW6 = TCG INT/EXT ON = INT

Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:
The parameter "Rec start shift" is not available.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/80c37956bef553a9c1256230004f1c3f?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/80c37956bef553a9c1256230004f1c3f?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/80c37956bef553a9c1256230004f1c3f?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/80c37956bef553a9c1256230004f1c3f?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:
It is not recommended to use this device as a recorder. It doesn´t support a standard EBU-LTC and the
REC IN in assemble mode is not clean.
Device was tested with vmmedia.dll from 09.05.95 and ag7150.vmp from 07.04.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/80c37956bef553a9c1256230004f1c3f?OpenDocument&ExpandSection=-5#_Section5


DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAG-7600E
Device Note 17.11.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front TC AUTO
At front Control REMOTE

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET under Counterdisplay button
when the SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
1001 SYNC 00 NORMAL
2004 PB/EE SELECT 00 PB/EE
3006 AUDIO CH2 01 LTC
5002 DEVICE TYPE SELECT 00 OTHER TYPES
6005 FRAME SERVO 01 ON

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f2b7af893fc80aedc1256277004e5b51?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f2b7af893fc80aedc1256277004e5b51?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f2b7af893fc80aedc1256277004e5b51?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f2b7af893fc80aedc1256277004e5b51?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
- While the RESET button on the VCR is kept pressed during Play (CONTROL switch to REMOTE and
DIAL MODE switch to SEARCH), you can see the VITC Position on VCR-Display and on screen (if ON
SCREEN is enabled).
- At the SYNC EXT setting, the COLOUR FRAME function does not operate, and only frame is
conducted.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/f2b7af893fc80aedc1256277004e5b51?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAG-7700E
Device Note 20.11.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front TC AUTO
At front Control REMOTE
At front Memory EDIT

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET under Counterdisplay button
when the SETUP-MENU is indicated.
Item nr. 7004 and 7005 (VITC Position SEL-1 and SEL-2) must be set for Line 19 and 21.

If using as Player, set Item nr. 6005 (FRAME SERVO) to 01-ON.
If using as Recorder, set Item nr. 6005 (FRAME SERVO) to 02-COLOUR FRAME.

EintragNr. Eintrag Einstellungen
1001 SYNC 00 NORMAL
2004 PB/EE SELECT 00 PB/EE
3006 AUDIO CH2 01 LTC
5002 DEVICE TYPE SELECT 00 OTHER TYPES

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7d1e573f6d16db84c125627a0037b97b?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7d1e573f6d16db84c125627a0037b97b?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7d1e573f6d16db84c125627a0037b97b?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7d1e573f6d16db84c125627a0037b97b?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
- While the RESET button on the VCR is kept pressed during Play (CONTROL switch to REMOTE and
DIAL MODE switch to SEARCH), you can see the VITC Position on VCR-Display and on screen (if ON
SCREEN is enabled).
- For First edit and TC dub the software selector 7002 (TC MODE) must be set to 02-FREE RUN.
Normaly the 7002 (TC MODE) is set to 00-REGEN.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7d1e573f6d16db84c125627a0037b97b?OpenDocument&ExpandSection=-5#_Section5


- At the SYNC EXT setting in the Software Setup on the Device, the COLOUR FRAME function does not
operate, and only frame is conducted.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAG-7750E
Device Note 07.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front TC REGEN
At front VITC ON
At front Control REMOTE

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
3003 Remote op. 9p
4004 FRAME SERVO CF / als Rekorder
3002 9P DEVICE TYPE SELECT OTHER TYPE 2
4004 FRAME SERVO On (Player)

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ca060462d580cef9c1256230002fe46b?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ca060462d580cef9c1256230002fe46b?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ca060462d580cef9c1256230002fe46b?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ca060462d580cef9c1256230002fe46b?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
None

Disclaimer:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/ca060462d580cef9c1256230002fe46b?OpenDocument&ExpandSection=-5#_Section5


FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAG-8600E
Device Note 27.11.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front TC AUTO
At front Control REMOTE

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET under Counterdisplay button
when the SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
1001 SYNC 00 NORMAL
2004 PB/EE SELECT 00 PB/EE
3006 AUDIO CH2 00 LTC
5002 TYPE DEVICE SELECT 00 OTHER TYPES
6005 FRAME SERVO 01 ON

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c4f8e2d68a912694c1256281003ca1e7?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c4f8e2d68a912694c1256281003ca1e7?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c4f8e2d68a912694c1256281003ca1e7?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c4f8e2d68a912694c1256281003ca1e7?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
- While the RESET button on the VCR is kept pressed during Play (CONTROL switch to REMOTE and
DIAL MODE switch to SEARCH), you can see the VITC Position on VCR-Display and on screen (if ON
SCREEN is enabled).
- At the SYNC EXT setting, the COLOUR FRAME function does not operate, and only frame is
conducted.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c4f8e2d68a912694c1256281003ca1e7?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAG-8700E
Device Note 21.11.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 422
Treiber: sonybc.vmp
FreigabeDatum: 24.04.96

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front TC AUTO
At front Control REMOTE
At front TBC ON

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET under Counterdisplay button
when the SETUP-MENU is indicated.
Item nr. 7004 and 7005 (VITC Position SEL-1 and SEL-2) must be set for Line 19 and 21.

If using as Player, set Item nr. 6005 (FRAME SERVO) to 01-ON.
If using as Recorder, set Item nr. 6005 (RFAME SERVO) to 02-COLOUR FRAME.

EintragNr. Eintrag Einstellungen
1001 SYNC EXT
2004 PB/EE SELECT 00 PB/EE
3006 AUDIO CH2 01 LTC
5002 DEVICE TYPE SELECT 00 OTHER TYPES

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/63abf634a73eb89fc125627b00537bfa?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/63abf634a73eb89fc125627b00537bfa?OpenDocument&ExpandSection=-2#_Section2
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Tips und Tricks/ Trouble shooting:
- While the RESET button on the VCR is kept pressed during Play (CONTROL switch to REMOTE and
DIAL MODE switch to SEARCH), you can see the VITC Position on VCR-Display and on screen (if ON
SCREEN is enabled).
- For First edit and TC dub the software selector 7002 (TC MODE) must be set to 02-FREE RUN.
Normaly the 7002 (TC MODE) is set to 00-REGEN.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/63abf634a73eb89fc125627b00537bfa?OpenDocument&ExpandSection=-5#_Section5


- Although adjusting the jog delay in the Device Setup\Setup\Customization the jog is a little bit
inaccurate.
-The bad sync given from AG-8700E might give problems to VM Studio e.g. if you make a GOTO
sometimes at the VM Output is shown only black. Jog 1 field forward and 1 field back and you will see the
right position.
- On audio channel 1 and 2 you will have a bad audio out cut. This is depending on the device itself.
- If you want to record only on audio channel 2, you have to set in the menue of AG-8700 item 3005 CH1
REC to CH1 and item 3006 AUDIO CH2 to Audio.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAJ-D350
Device Note 26.02.96

Typ:
System: D3
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/b0c35f89d2f9b63ec12562dc0050e5ea?OpenDocument&ExpandSection=-1#_Section1
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Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/b0c35f89d2f9b63ec12562dc0050e5ea?OpenDocument&ExpandSection=-5#_Section5


THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAJ-D580
Device Note 06.03.96

Typ:
System: D5
TV Standard: PAL
Remote: RS 422
Treiber: sonybc.vmp
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/9b63078257a4c9dcc12562e50056578d?OpenDocument&ExpandSection=-1#_Section1
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Tips und Tricks/ Trouble shooting:
None

Disclaimer:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/9b63078257a4c9dcc12562e50056578d?OpenDocument&ExpandSection=-5#_Section5


FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAJ-D650
Device Note 04.06.97

Typ:
System: DVC PRO
TV Standard: PAL
Remote: RS 422
Treiber: SONYBC.VMP
FreigabeDatum: 04.06.97

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front TC INT
At front VIDEO IN ANALOG
At front MUSIC IN ANALOG
At front REMOTE

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.
If you want to use DV cassetts you have to set item number
108 to DV

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/06b0c31c38c6616dc12564ac00622ddf?OpenDocument&ExpandSection=-1#_Section1
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Tips und Tricks/ Trouble shooting:
None

Disclaimer:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/06b0c31c38c6616dc12564ac00622ddf?OpenDocument&ExpandSection=-5#_Section5


FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAJ-D750
Device Note 28.10.96

Typ:
System: DVCPRO
TV Standard: PAL
Remote: RS 422
Treiber: sony.vmp date 24.04.96
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front Control Remote REMOTE
At front TC INT
Under front hidden TC REGEN
Under front hidden TC REC RUN
Under front hidden CF 2FD Player, 4FD or 8FD

Recorder
Under front hidden SYNCRONIZE ON

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar: Pay attention that "SCH" lamp is aktive, otherwise you have a bad ref. signal. To avoid this
connect VM Ref Out directly to VTR Ref. In

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.
104 REF ALARM ON
106 PLAY DELAY 0
308 CONFI EDIT ON

EintragNr. Eintrag Einstellungen
0 PREROLL TIME 5 sec
107 CAP. LOCK 8 FIELD (RECORDER)
202 ID SEL OTHER

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3c759d6b916f2e3ac12563d1004c4c22?OpenDocument&ExpandSection=-1#_Section1
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304 SERVO REF EXT
508 TCG CF FLAG ON

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3c759d6b916f2e3ac12563d1004c4c22?OpenDocument&ExpandSection=-4#_Section4


Tips und Tricks/ Trouble shooting:
- VTR is not able to read and generate VITC, only LTC is supported!
- VAR Speed is not supported

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3c759d6b916f2e3ac12563d1004c4c22?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAU-65H
Device Note 06.09.95

Typ:
System: MII
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
4002 EDIT FIELD SELECT ODD

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/6a8cf00488c4759cc125622f0064ad72?OpenDocument&ExpandSection=-1#_Section1
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Tips und Tricks/ Trouble shooting:
Choose GENLOCKED, if the device is genlocked with an external sync signal.
and chooseTC board available, if there is a TC board installed.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/6a8cf00488c4759cc125622f0064ad72?OpenDocument&ExpandSection=-5#_Section5


WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicAU-W35R
Device Note 19.11.96

Typ:
System: MII
TV Standard: PAL
Remote: RS 422
Treiber: SONYBC.VMP
FreigabeDatum: 19.11.96

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

Under front hidden SYNC SELECT EXT
Under front hidden CF 2FD (Player), 8FD (Recorder)
Under front hidden Play Delay 0
Under front hidden Synchronize ON

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
3004 9P DEVICE TYPE SELECT OTHER TYPE 2

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0a74d7cd564c5d33c12563e7005b248a?OpenDocument&ExpandSection=-1#_Section1
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Tips und Tricks/ Trouble shooting:
Be sure, that the REF SCH Led is on. If not, trimm the Tools/Output Setup/Encoder/H fsc Phase.

Disclaimer:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0a74d7cd564c5d33c12563e7005b248a?OpenDocument&ExpandSection=-5#_Section5


FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

PanasonicNV-F 77EG
Device Note 07.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:

Increase EDIT OFF DELAY, if you have blackframes as recorder

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/2cdd28d1af4c9248c12562300030982b?OpenDocument&ExpandSection=-1#_Section1
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Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE
IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS.
FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN.
EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES
NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT
RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE
CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION
PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY
AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON
SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

PanasonicNV-FS 200
Device Note 07.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
None

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/804331e802bc15ecc12562300031623c?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/804331e802bc15ecc12562300031623c?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/804331e802bc15ecc12562300031623c?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/804331e802bc15ecc12562300031623c?OpenDocument&ExpandSection=-4#_Section4
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/804331e802bc15ecc12562300031623c?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE
IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS.
FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN.
EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES
NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT
RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE
CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION
PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY
AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON
SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



PanasonicNV-FS 200 PC
Device Note 04.09.95

Typ:
System: S-VHS, VHS
TV Standard: PAL
Remote: RS 232
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

Under front hidden INPUT SELECT A4

Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0f2a549dcf285924c125622d005f9d32?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0f2a549dcf285924c125622d005f9d32?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0f2a549dcf285924c125622d005f9d32?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0f2a549dcf285924c125622d005f9d32?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:
RTV-950 PC is the compatible driver

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0f2a549dcf285924c125622d005f9d32?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

PanasonicNV-FS 88EG
Device Note 07.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
None

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e43af9076a594296c125623000304f43?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e43af9076a594296c125623000304f43?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e43af9076a594296c125623000304f43?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e43af9076a594296c125623000304f43?OpenDocument&ExpandSection=-4#_Section4
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e43af9076a594296c125623000304f43?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE
IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS.
FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN.
EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES
NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT
RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE
CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION
PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY
AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON
SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

PanasonicNV-FS 90
Device Note 07.09.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
None

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/6de3c6d95723070ac12562300032b71b?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/6de3c6d95723070ac12562300032b71b?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/6de3c6d95723070ac12562300032b71b?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/6de3c6d95723070ac12562300032b71b?OpenDocument&ExpandSection=-4#_Section4
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/6de3c6d95723070ac12562300032b71b?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE
IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS.
FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE)
CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN.
EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES
NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT
RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE
CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE INFORMATION
PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY
AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON
SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Video Machine - Device Notes

NV-FS 90
NV-HS 1000
NV-HS 800
NV-HS900
NV-MS 4E
NV-MS 90
NV-MS95
NV-S 8E
NV-V 8000EG

RICOH
Sanyo
Sony
Tektronix

[
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© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/972a8a2382641e92c125622d005d82f8?OpenDocument
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/7f8aac77fcc408b5c125622d005f531c?OpenDocument
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/e68d5e13d5729039c12563da005c15cb?OpenDocument
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/8b138b45f8f4ee8ec125623000300b7c?OpenDocument
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/0a4ea1c98376d850c12562300032dad4?OpenDocument
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/65c95801c014135ec125633a003af964?OpenDocument
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4c0503e48aa1aef6c125623000302e18?OpenDocument
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/b9573b0933b49ba0c12562300033b8b8?OpenDocument
http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=6.24&Count=30&Expand=7#7
http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=6.24&Count=30&Expand=8#8
http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=6.24&Count=30&Expand=9#9
http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=6.24&Count=30&Expand=10#10
http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=10&Count=30&Expand=6#6


Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix

[
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© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=10&Count=30&Collapse=7#7


 

RICOH R-18H
Device Note 06.09.95

Typ:
System: Hi8
TV Standard: NTSC
Remote: LAN-C/Control L
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings at
machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:

*OEM model, compatible to Sony CCC TR-101
** Work with LANC.VMP driver edit level 2.0
* TC switch at menu to "counter"
* Machine only godd as player, since you have to choose Video-input OR output!!!

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/2cc7832fbb7ab7c1c125622f005eefbf?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/2cc7832fbb7ab7c1c125622f005eefbf?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/2cc7832fbb7ab7c1c125622f005eefbf?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/2cc7832fbb7ab7c1c125622f005eefbf?OpenDocument&ExpandSection=-4#_Section4
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/2cc7832fbb7ab7c1c125622f005eefbf?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS
DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE.
THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES
AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Video Machine - Device Notes

Tektronix
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix

[
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© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=10&Count=30&Collapse=8#8


Sanyo GVR-S955
Device Note 06.09.95

Typ:
System: S-VHS / VHS
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
At front SYNC SELECT EDIT (RECORDER)
Backside Audio CH2 select Timecode

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside Ref video Ref-out or Composite out

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU
is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3cd97b9264fa1176c125622f005cc6a7?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3cd97b9264fa1176c125622f005cc6a7?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3cd97b9264fa1176c125622f005cc6a7?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3cd97b9264fa1176c125622f005cc6a7?OpenDocument&ExpandSection=-4#_Section4


 



 

Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/3cd97b9264fa1176c125622f005cc6a7?OpenDocument&ExpandSection=-5#_Section5


CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION
CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS
DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE
EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR
IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE
USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED
ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Sanyo GVR-S960
Device Note 02.11.95

Typ:
System: S-VHS
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front SYNC SELECT EDIT
At front TC AUTO
At front Frame servo 2FD (Player), 4FD (Recorder)
At front Control REMOTE
At front TBC OFF
At front Input Select Composite

Kommentar: all these settings have to be applied as player too

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Sync In
Backside VTR LTC Out VM LTC In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c59327aa1e2dea87c1256268005e6bac?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c59327aa1e2dea87c1256268005e6bac?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c59327aa1e2dea87c1256268005e6bac?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c59327aa1e2dea87c1256268005e6bac?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
If Sanyo GVR-S960 is used as recorder preroll time has to be 12seconds.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/c59327aa1e2dea87c1256268005e6bac?OpenDocument&ExpandSection=-5#_Section5


WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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Video Machine - Device Notes
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© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=10&Count=30&Collapse=9#9


Sony BVU-870P
Device Note 07.09.95

Typ:
System: U-matic HB
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1bafeba7eed33312c1256230004d93a3?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1bafeba7eed33312c1256230004d93a3?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1bafeba7eed33312c1256230004d93a3?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1bafeba7eed33312c1256230004d93a3?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:
Achtung:
Colorframing nur mit entsprechender HW.
Gerät kann nicht bumpen -
Bei Preview in Clip Editor oder Timeline Err 74
Wenn Bumper / Cann compensate / Cann do 5%bumps angeklickt -> err 74
*also : nicht als Player volltauglich.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/1bafeba7eed33312c1256230004d93a3?OpenDocument&ExpandSection=-5#_Section5


Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Sony BVW-15P
Device Note 04.09.95

Typ:
System: Betacam
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn

vorhanden)
Switch Position

At front REMOTE 9P
Under front hidden CAPSTAN LOCK 2FD

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d6eff0d780de0a5cc125622d005fc1f3?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d6eff0d780de0a5cc125622d005fc1f3?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d6eff0d780de0a5cc125622d005fc1f3?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d6eff0d780de0a5cc125622d005fc1f3?OpenDocument&ExpandSection=-4#_Section4


 



 

Tips und Tricks/ Trouble shooting:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d6eff0d780de0a5cc125622d005fc1f3?OpenDocument&ExpandSection=-5#_Section5


PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Sony BVW-40P
Device Note 06.09.95

Typ:
System: Betacam
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
At front MODE (Recorder) edit
Backside SYNC SELECT EXT

Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside Ref in VM composite out or

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU
is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/a5598608a8570a84c125622f005c4e01?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/a5598608a8570a84c125622f005c4e01?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/a5598608a8570a84c125622f005c4e01?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/a5598608a8570a84c125622f005c4e01?OpenDocument&ExpandSection=-4#_Section4


 



Tips und Tricks/ Trouble shooting:
The machine can't read VITC when using VM VITC. Switch the TBC control selector to bypass.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/a5598608a8570a84c125622f005c4e01?OpenDocument&ExpandSection=-5#_Section5


CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION
CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS
DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE
EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR
IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE
USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS
OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN
PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED
ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Sony BVW-60P
Device Note 07.09.95

Typ:
System: Betacam SP
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
401 After Cue Still

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/610870d8470ae2d4c12562300033edc7?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/610870d8470ae2d4c12562300033edc7?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/610870d8470ae2d4c12562300033edc7?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/610870d8470ae2d4c12562300033edc7?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/610870d8470ae2d4c12562300033edc7?OpenDocument&ExpandSection=-5#_Section5


PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Sony BVW-65P
Device Note 07.09.95

Typ:
System: Betacam SP
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
401 After Cue Still

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/11fdcb68c83496ecc125623000495408?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/11fdcb68c83496ecc125623000495408?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/11fdcb68c83496ecc125623000495408?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/11fdcb68c83496ecc125623000495408?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/11fdcb68c83496ecc125623000495408?OpenDocument&ExpandSection=-5#_Section5


PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Sony BVW-70P
Device Note 07.09.95

Typ:
System: Betacam SP
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
401 After Cue - still

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/683e80e6f51215a5c1256230004dbb07?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/683e80e6f51215a5c1256230004dbb07?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/683e80e6f51215a5c1256230004dbb07?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/683e80e6f51215a5c1256230004dbb07?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/683e80e6f51215a5c1256230004dbb07?OpenDocument&ExpandSection=-5#_Section5


PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Sony BVW-75P
Device Note 06.09.95

Typ:
System: Betacam SP
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
401 After Cue - still

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/dd5541f4815b8868c125622f005f95a3?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/dd5541f4815b8868c125622f005f95a3?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/dd5541f4815b8868c125622f005f95a3?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/dd5541f4815b8868c125622f005f95a3?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/dd5541f4815b8868c125622f005f95a3?OpenDocument&ExpandSection=-5#_Section5


PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Sony BVW-95P
Device Note 07.09.95

Typ:
System: Betacam SP
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
401 After Cue - Still

Standard Einstellungen für Treiber/ Default settings for driver:

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/58b66207963ed193c12562300049b1f1?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/58b66207963ed193c12562300049b1f1?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/58b66207963ed193c12562300049b1f1?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/58b66207963ed193c12562300049b1f1?OpenDocument&ExpandSection=-4#_Section4


 

Tips und Tricks/ Trouble shooting:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/58b66207963ed193c12562300049b1f1?OpenDocument&ExpandSection=-5#_Section5


PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Sony BVW-96P
Device Note 07.09.95

Typ:
System: Betacam SP
TV Standard: PAL
Remote: RS 422
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

EintragNr. Eintrag Einstellungen
401 After Cue - Still

Standard Einstellungen für Treiber/ Default settings for driver:
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Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/4edc7916e556f120c12562300049f4e2?OpenDocument&ExpandSection=-5#_Section5


PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Sony CCD-FX 400E
Device Note 07.09.95

Typ:
System: Video8
TV Standard: PAL
Remote: Edit-Control
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings at
machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
None

Disclaimer:
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FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS
DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE.
THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES
AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Sony CCD-FX 700E
Device Note 07.09.95

Typ:
System: Hi8
TV Standard: PAL
Remote: LAN-C/Control L
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings at
machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
None

Disclaimer:
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FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS
DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE.
THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES
AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Sony CCD-TR 2000E
Device Note 07.09.95

Typ:
System: Hi8
TV Standard: PAL
Remote: LAN-C/Control L
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
At front CAMERA/PLAYER PLAYER
at front by the display COUNTER/TIME CODE TIMECODE

Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings
at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:
Not optimised
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Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE
INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE
ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT
NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/d92cf772783e736bc1256230004f4850?OpenDocument&ExpandSection=-5#_Section5


 

Sony CCD-TR 323
Device Note 07.09.95

Typ:
System: Video8
TV Standard: PAL
Remote: LAN-C/Control L
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings at
machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
CCD-TR323 is working with the default parameters for LANC Level 2.0, except Play delay has to be 8 fields. No special
further adjustments necessary

Disclaimer:
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FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS
DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE.
THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES
AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Sony CCD-TR 750E
Device Note 07.09.95

Typ:
System: Hi8
TV Standard: PAL
Remote: LAN-C/Control L
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings at
machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:
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Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS
DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE.
THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES
AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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Sony CCD-TR 808 E
Device Note 06.09.95

Typ:
System: Hi8
TV Standard: PAL
Remote:
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings at machine if
not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
None

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER

http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/41ec53f8b23a5285c125622f005d1232?OpenDocument&ExpandSection=-1#_Section1
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/41ec53f8b23a5285c125622f005d1232?OpenDocument&ExpandSection=-2#_Section2
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/41ec53f8b23a5285c125622f005d1232?OpenDocument&ExpandSection=-3#_Section3
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/41ec53f8b23a5285c125622f005d1232?OpenDocument&ExpandSection=-4#_Section4
http://www.fast-broadcast.com/ibase.nsf/11f3b7bd970a2924c125688500597687/41ec53f8b23a5285c125622f005d1232?OpenDocument&ExpandSection=-5#_Section5


EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Sony CCD-VX 3
Device Note 06.09.95

Typ:
System: Hi8
TV Standard: NTSC
Remote: LAN-C/Control L
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings
at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
No special settings
* Machine only good as player, since you have to choose Video-input OR output!!!
* Work with LANCRCTC.VMP driver.
*TC switch at menu to TC.
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Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE
INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE
ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT
NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Sony CVD-1000
Device Note 07.09.95

Typ:
System: Hi8
TV Standard: NTSC
Remote:
Treiber:
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings at
machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
None
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Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO
WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES
OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY
TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION PROVIDED WILL BE
EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS IN THIS DATABASE OR IN ANY
TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT NOTICE. THE USER OF THE
INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS CONCERNING ITS
ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS
WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES
AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Sony DCR-PC7E
Device Note 06.02.97

Typ:
System: DVC
TV Standard: PAL
Remote: LAN-C/Control L
Treiber: LANCRCTC.VMP
FreigabeDatum: 97/01/17

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
At front Power Player

Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings
at machine if not default:

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
You must have the Adapter VMC-LM7, to connect the LancControl.

Disclaimer:
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FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE
INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE
ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES
AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Sony DCR-VX1000E
Device Note 20.01.97

Typ:
System: DV
TV Standard: PAL
Remote: LAN-C/Control L
Treiber: LANCRCTC.VMP
FreigabeDatum: 07.01.97

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings
at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.

Standard Einstellungen für Treiber/ Default settings for driver:

Tips und Tricks/ Trouble shooting:
To connect the DCR-VX1000E to an older SC-Box, a 5k resistor must be removed from each E-Control output.

Disclaimer:
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FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE
INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE
ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT
NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Sony DCR-VX9000E
Device Note 08.01.97

Typ:
System: DV
TV Standard: PAL
Remote: LAN-C/Control L
Treiber: LANCRCTC.VMP
FreigabeDatum: 07.01.97

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar: No switch settings needed

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside LanC LanC in SC-Box Control
Rightside S-Video out SC-Box S-Video in
Rightside Audio R/L out SC-Box Audio in

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the
SETUP-MENU is indicated.

Standard Einstellungen für Treiber/ Default settings for driver:
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Tips und Tricks/ Trouble shooting:
PAL Device has not any record modes

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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Sony DHR-1000VC
Device Note 18.10.96

Typ:
System: DV
TV Standard: PAL
Remote: LAN-C/Control L
Treiber: LANCRCTC.VMP date:04.03.96
FreigabeDatum:

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Ort Switch Name (wenn vorhanden) Switch Position
Operation Panel Input Select used input connector (1-4)

Kommentar:

Connectors:

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software settings
at machine if not default:
To return set-up items to the default (factory-set) settings, press the RESET button when the SETUP-MENU is
indicated.
To enter in software set-up, press the MENU button on OPERATION PANEL.
-Navigation with Cursor buttons
- Confirm with EXECUTE Button.
(Attention: settings are not stored after power is disconnected !)

EintragNr. Eintrag Einstellungen
1 SET UP MENU
2 LAN C MODE (default M) S
3 L3 IN VIDEO (default NORM) S

Standard Einstellungen für Treiber/ Default settings for driver:
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Tips und Tricks/ Trouble shooting:
- "A1 Insert only" in 12 Bit Mode ( VCR records Audio on 2. Stereotrack ! )
- "A2 Insert only" causes Errorcode 65

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS
PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES
NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS
DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION
AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE
INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE
ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE
AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS
KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE
EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT CUSTOMERS OF FAST MAY PRINT A COPY OF THIS
KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT
NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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Video Machine - Device Notes

DHR-1000VC
DNW-A100P
DSR-200P
DSR-200P
DSR-30P
DSR-30P
DSR-60P
DSR-60P
DSR-80P
DSR-85
DSR-85
DVW-A500P
EV-C 100
EV-C 2000E
EV-S 3000
EV-S 550
EV-S 850PS
EV-S 880E
EV-S 9000E
EVO-9100
EVO-9720
EVO 9650P
PVW-2800P
SVO-5800P
SVO-9620
SVP-5600P
SVP-9020
UVW-1200P
UVW-1400P
UVW-1600P
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Video Machine - Device Notes

Blaupunkt
Canon
JVC
Mitsubishi
Otari
Panasonic
RICOH
Sanyo
Sony
Tektronix
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TektronixPDR 100 Video Disk Recorder (Profile)
Device Note 14.01.97

Typ:
System: Video Disk Recorder
TV Standard: NTSC/PAL
Remote: RS 422
Treiber: SONYBC.VMP
FreigabeDatum: 18.12.96

Hardware Setup am Gerät: / Hardware setup at machine
Switches:
Kommentar:

Connectors:

Ort Connector Out (wenn
vorhanden)

Connect to (In)

Backside VM Ref or Composite Out VTR Ref. In

Kommentar:

Software Einstellung am Gerät, wenn unterschiedlich von der Vorgabe: / Software
settings at machine if not default:
The Profile supports PAL and NTSC. It was tested with NTSC. This device is available in several
configurations. The Profile we had here at FAST was equipped with
1 composite analog output board (= 1 analog comosite input)
1 composite analog input board (= 4 analog composite outputs)
2 digital component input/output boards (each has two input and two outputs)
4 analog audio boards (each has 4 XLR inputs and 4 XLR outputs)
8 HDDs (Seagate 15150 4 GB Wide SCSI)
1 Genlock board
1 RS422 controller board for 8 RS 422 interfaces connected via a breakout RS422 box.

The Profile has 4 (independent) M-JPEG channels. In the Vdr-Panel (= program which controls the
Profile) you may setup a Control Panel for each M-JPEG channel. For each control panel you define a
controller (Panel Control, Louth Automation, Odetics Broadcast, BVW, BVW (insert edit).
Note: 2 M-JPEG channels are needed for a BVW (insert edit) panel, for the other controller types only
one M-JPEG channel is needed.

We tested 2 SW configurations:
1. One control panel (= panel A) as a BVW (insert edit) Panel
2. Three control panels, Panel A as a BVW (insert only), panel B as a BVW, panel C as a BVW.

Panel A was configured as follows:

Pb video: JPEG#1 Pb audio: Chan#1, Chan#3 Pb TC: TCRec#1, TCRec#3
Rec video: JPEG#2 Rec audio: Chan#2, Chan#4 Rec TC: TCRec#2, TCRec#4
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Panel B was configured as follows:

Video: JPEG#3 Audio: Chan#5, Chan#6 TC: TCRec#5, TCRec#6

Panel C was configured as follows:

Video: JPEG#4 Audio: Chan#7, Chan#8 TC: TCRec#7, TCRec#8

For all Panels:
Video compression presets: Highest quality, least recording time
TC: LTC NDF
Field dominance: 1

Note: Don't forget to make the correct connections in the Video Crosspoint Setup outherwise you may get
no output signal! Same for the TC Crosspoint setup.

In the PDR 100 Configuartion Tool SW you may select the video standard (PAL / NTSC) and adjust
reference timing.
We genlocked the device to the SC-Box FBAS Master Out, which should give you the following
Reference Genlock Lock Status:
Locked to Ext. Ref, Internal Clock Locked, NTSC (PAL if you use PAL).
No Reference Genlock System Advance Adjustment was necessary.

Standard Einstellungen für Treiber/ Default settings for driver:
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Tips und Tricks/ Trouble shooting:
No VARS supported because QueryVarS command not supported by the Profile
No TL scrub of Profile clips supported
Continues play of Profile clips only if clip length >5 sec.
VITC not tested.
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Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR
TECHNOTE IS PROVIDED "AS-IS" SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S
CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER EXPRESS OR IMPLIED (INCLUDING,
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE
INFORMATION CONTAINED THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING
ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT GUARANTEE THAT THE INFORMATION
PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR OMISSIONS
IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE
WITHOUT NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR
TECHNOTE ASSUMES ALL RISKS CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE
LICENSE AGREEMENT AND WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO
PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY BE COPIED, REPRODUCED OR
DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR
THEIR OWN PERSONAL USE SO LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS
REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



Video Machine - Device Notes

PDR 100 Video Disk Recorder (Profile)
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Video Machine - Device Notes

Tektronix
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Video Machine - Device Notes

Tektronix
PDR 100 Video Disk Recorder (Profile)

[
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© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/b_us_vmdn?OpenView&Start=10&Count=30&Collapse=10#10


Video Machine - Cable & Pin Layouts

Alladin cabling with VM / analog Devices
Edit Control Pin-Out Plan
LanC Pin-Out Plan
Multi I/O Professionel Configuration
Pin Connenction VM Board
VMIO - RS232 cable for Blaupunkt RTV 950-PC
VMIO - RS232 cable for Mitsubishi E82
VMIO - RS232 cable for Panasonic AG5700, AG7150
VMIO - RS232 cable for Sony CVD1000 (Visca)
VMIO - RS232 for Philips VP-410
VMIO - RS232 for Pioneer Laserdisc Players
VMIO - RS422 cable - 9 pin <> 9 pin
VMSC box - RS232 cable for Mitsubishi E82
VMSC box - RS232 cable for Philips VP-410
VMSC box - RS232 cable for Pioneer Laserdisc Players
VMSC box - RS232 cable for Pioneer LDV-4300D, LD-V8000, LD-V4200, LD-V2200, LD-V4100
VMSC box - RS232 cable for UVW-1200P
VMSC box - RS232 cable for VCR: Sony CDV-1000 (Visca)
VMSC box - RS232 cable forr Blaupunkt RTV 950-PC
VMSC box - RS422 cable - 9-pol <> 9-pol

[

 Previous Page | Next Page 

<br>]

© Copyright FAST Multimedia AG. All rights reserved.
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Machine

Alladin cabling with VM / analog Devices

PIN/ Kabel 28.11.95

This cable plan displays the connection to the Alladin Media Printer together with two analog player devices and Y/C
player/recorder only. The DPR Out board is not involved in the process, thus you cannot use digitized material as a input for
Alladin effects .

The SYNC IN of the recorder can be connected to the FBAS Out of the SC Box, in loop with the SYNC cabling of the player
device.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT



CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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Machine

Edit Control Pin-Out Plan

PIN/ Kabel 06.09.95

Pin-Out Plan Panasonic Edit Control to 3.5 mm Stereo
Plug (VM)

Please observe that pins #1 and #5 on the 5 pin ECtrl plug are not connected.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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LanC Pin-Out Plan

PIN/ Kabel 06.09.95

Pin-Out Plan LanC-Connectors to 3.5 mm Stereo Plug
(VM)

Two different types of plugs are available to control LanC compatible devices:
1) a 5 pin version (see below) and
2) a 2.5 mm stereo plug (similar to headphone plugs)

1)

2)

Simply connect both plugs "1:1", i.e., connect tip to tip, middle ring to middle ring and bottom ring to bottom ring.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO



LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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Multi I/O Professionel Configuration

PIN/ Kabel 04.03.97

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.

http://www.fast-broadcast.com/ibase.nsf/0011e0f0b1e51812c12568830058b42c/b93d4d6af1d89490c12564500038fb55/$FILE/M-io-pr1.tif


 

Video
Machine

Pin Connenction VM Board

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS



CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMIO - RS232 cable for Blaupunkt RTV 950-PC

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMIO - RS232 cable for Mitsubishi E82

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMIO - RS232 cable for Panasonic AG5700, AG7150

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMIO - RS232 cable for Sony CVD1000 (Visca)

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMIO - RS232 for Philips VP-410

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMIO - RS232 for Pioneer Laserdisc Players

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMIO - RS422 cable - 9 pin <> 9 pin

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMSC box - RS232 cable for Mitsubishi E82

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMSC box - RS232 cable for Philips VP-410

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMSC box - RS232 cable for Pioneer Laserdisc Players

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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VMSC box - RS232 cable for Pioneer LDV-4300D, LD-V8000, LD-V4200,
LD-V2200, LD-V4100

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Video
Machine

VMSC box - RS232 cable for UVW-1200P

PIN/ Kabel 06.09.95

Null-Modem-Kabel

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY



BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Video
Machine

VMSC box - RS232 cable for VCR: Sony CDV-1000 (Visca)

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Video
Machine

VMSC box - RS232 cable forr Blaupunkt RTV 950-PC

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

Video
Machine

VMSC box - RS422 cable - 9-pol <> 9-pol

PIN/ Kabel 06.09.95

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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FAST VMPC Technote
Vivanco VCR 5050 Panasonic EditControl ->Sony LanC convertor
01.02.99

Description/ Symptoms:

The Vivanco VCR 5050 Panasonic Edit 5pin to Sony LanC protocol convertor was tested in an attempt to provide a solution for
customers wishing to use Panasonic Digital decks with the new digital time code (please see tech note number 56)

The device did not pass our tests and is therefore not supported for use with Video Machine.

Background:

Solution:

Comments:

Video Machine Tech Note number 56

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
Clean re-installation instructions for VM-Studio
19.01.99

Description/ Symptoms:

We recommend that you uninstall any previous versions of VM-Studio prior to installing version 3.3 and 3.98a. This technical note details
how to uninstall an earlier version from Windows 95.

Using the following instructions, your movies, projects, graphics and EDLs will all be backed up and remain saved. If you habitually save
these files somewhere other than in the default directories, you should also back up these other directories. DP/R users will find that the
information on their DP/R drives will also be unaffected.

Un-installation:

1. Open VM-Studio. Go to Tools and choose Hardware Setup then write down the three settings (I/O Base, Memory Base and IRQ
Level). Then, go to Tools>Device Setup and make notes of all the devices you have set up there and what settings each of them is
using. Also, if you have VM Plus! go to Render>Options>Plugin Settings and note each of the directories listed. Quit VM-Studio

2. Go into Windows Explorer. Create a new folder under your root directory and move the Edl, Images, Movies and Projects folders from
the VMStudio directory to the new folder (Hint: The 'Alt Gr' key, usually found to the right of the space bar, allows selection of multiple
items).

3. Choose Start>Settings>Control Panel and go into Add/Remove Programs. In the dialog box, click on ////FAST Electronic Inc. VM
Studio and then click the 'Add/Remove' button. Choose 'Custom' uninstall. On each of the following windows, simply click 'Select All' and
'Continue'. If the program gives any messages about shared files, allow the program to delete the files.

4. The uninstall program usually removes all Video Machine files. However, sometimes a few files are left behind which must be found
and removed. To do this, go to Start>Find>Files or Folders and search for and delete the following files:

tcolor.drv
tcflt.ini
vm.ini
tcdrv.ini
smip.dll
vmstudio.grp

Restart your system before beginning the 3.3 installation.

Re-installation:

1. Put the CD in the drive and close the draw. Follow the prompts through the installation procedure (making sure to check the DPR and
or YUV options if necessary). It is very important to make sure that, on the screen asking which TV standard you wish to use, the bottom
check box (concerning the titler) is checked. Reboot the system when asked.

2. Install Service Release 3.98a.

3. Run the VM Studio program and when you get to the Hardware Setup screen, select Custom Setup. Using the pull down menus,
select the numbers you wrote down previously from the Hardware Setup dialog. Click on the Test Memory button and accept any
changes recommended to the system files.

4. Finally, if you have the YUV Option, go to Tools>Output Setup and under the PAL pull-down, choose the 'YCbCr'option (normally the
last on the list).

5. If you have VM Plus! go to Render>Options>Plugin Settings and using the 'Add' button select, one by one, the directories that you
noted down previously.

Video Machine is now ready to use.

Background:

Solution:

Comments:



Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
VM Plus! Dongle Issues
08.12.98

Description/ Symptoms:

The VM Plus! dongle is "transparent" to the system and so anything plugged into the back of it should still be able to communicate with
the computer effectively

However, if you experience problems and can't connect the dongle to the back of whatever the device is, then there is a way to force the
system to look for the dongle. (This method also works if the dongle is not recognised) The following step-by-step instructions explain
how this can be done.

Background:

Solution:

1. Go to Start>Settings>Control Panel

2. Double click the "System" icon

3. Click the "Device Manager" tab

4. Expand the "Ports (COM & LPT)" branch

5. Double click on the port to which the dongle is connected

6. Click the "Resources" tab

7. Write down the first number in the "Settings" column next to "Input/Output Range" ignoring any zeros at the beginning of the
number. This number is the port's I/O address.

8. "OK" out of everything back to Windows

9. Go to Start>Run

10. Type "sysedit" and hit return

This will bring up one window with several others inside it. The 'closest' of the multiple inside windows will be called

C:\AUTOEXEC.BAT

On a new line at the bottom this closest window, add the command

SET HL_SEARCH=[port's I/O address] [ p | s ]

(p is used to denote that the port is parallel and should be used for the printer port, s that it is serial and should be used for COM1and
COM2).
For example, if the address of your serial port (COM2) is 02F8, then type:

SET HL_SEARCH=2F8s

or if the address of your Printer Port (LPT1) is 0378, then type:

SET HL_SEARCH=378p

When you save this file and re-start the system, if the dongle is connected correctly to the port, the dongle should be found correctly.
(Please note that whether the port is parallel or serial effects which side of the dongle is connected to the computer. Dongles are labelled
"Serial" on one edge, and "Parallel" on the other.)

Comments:



Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
How to Multilayer with Boris FX and VM Studio with VM Open
06.11.98

Description/ Symptoms:
1. Using VM Open, convert a clip from the DPR to a full resolution, full quality AVI (a large system drive or separate SCSI AV drive
other than your DPR drives comes in handy at this point!).
2. Go into VM-Studio and place the Boris FX DVE on the time line between your incoming and outgoing clips.
3. Double click on the Boris FX DVE and click the Custom button.
4. Choose a pre-set effect or make up your own, using three or more tracks of video.
5. Click on the track which corresponds to your third video source and click the 'Media' button at the bottom of the Boris window.
6. Using the 'Media:' pull down menu, choose 'Movie File' and select the AVI created previously with VM Open.

The selected track will now be playing the chosen clip from the AVI (please note that if you choose Preview>Image>Proxy, this AVI will
still be viewed as the source, and not as a proxy).

For the 4th, 5th, 6th.....Nth tracks, repeat the process.

Background:

Solution:

Comments:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
Video Machine and Windows 'handles' (working with large movies)
06.11.98

Description/ Symptoms:

The performance of VM-Studio is reduced when making a large movie with lots of clips on the time line.

Background:

Windows 95/98 allocates 5000 'handles' to each application while it is running. Video Machine needs 3 handles for each clip or effect on
the time line and each clip in the project (so on the time line, a video clip with stereo audio associated with it requires 9 handles - 3 for the
video clip, 3 for the left hand portion of the audio clip and 3 for the right hand portion of the audio clip).

When an application has used all of it's handles, that application's performance will be adversely affected because it's resources have
been stretched too far.

Solution:

To avoid running out of handles when making long movies, FAST recommend that longer movies should be split into several sections,
each section having a separate time line (and thus a separate *.mov file). These movie can then be joined together (on a frame accurate
record deck) by setting the 'Timeline begin' (Tools>Output Setup) to the exact time code as the last frame of the previous section.

Comments:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
VM PLUS FAQ's
05.11.98

Description/ Symptoms:

I can't find my F/X Studio Software on the CD. It says it on the CD but I can't find it.

There is no "F/X Studio" program per se. F/X Studio is a collection of Ulead Plug-in Effects and Filters and are loaded directly into and
accessed from VM-Studio PLUS. There is no stand alone program. You access them via the Ulead Effects group in the case of Effects
and Filters appear in the Plug-Ins selection located under the Tools button in the Clip Editor.

I have seen a DPR Calibrate program on other systems but, for some reason I don't have it.

This program calibrates Plus, the VM, DPR and the YUV together to set the shifting registers so that the images don't shift when
exported and re-imported during the rendering process. This is only needed when a YUV is present and therefore only installs when you
select Install YUV Option during the setup. (See also PLUS manual)

Image shifting or chroma shifting problems with YUV.

The customer needs to run the DPR Calibrate program before he/she begins to work with PLUS. It's a simple program that you simply
run. There are no options. The manual talks more about this.

Does VM-Studio PLUS work with my Alladin and/or DPR Out Board?

Yes and no. Yes VM-Studio PLUS does support the Alladin and/or DPR Out board however, it only works the way it did in 3.0. PLUS
does not add any new features to the functioning of the Alladin with or without the DPR Out board. PLUS will not do any rendering with
the Alladin, therefore you cannot use the Alladin to accelerate 3D effects. Also, the Optimize Movie function will not allow for continuous
playback while using the DPR Out and/or Alladin.

The packaging says that VM-Studio PLUS is a 32 bit program if this is true then can I run this under Windows NT?

What the box actually says is "True 32 bit Power for Windows 95." The answer is that the old portion that is to say the CORE of
VM-Studio is still a 16 bit application. The new rendering engine is 32 bit and therefore requires Windows 95. There is NO Windows NT
support for VM-Studio PLUS.

I keep getting flashing during my rendered clips.

Try adding one of these to the VM.INI File under the appropriate sections:

[RENDER]
NOCOPY=1 (instead of copying, the clip will always be rendered)

When I Optimize Movie the Ulead/Adobe/3rd Party effects are not rendered. What am I doing wrong?

Unfortunately the optimize function is not smart enough to render Effects that need rendering before it does the optimizing. You must first
render his/her plug-in effects before optimizing. To accomplish this you must use the following procedure:

Select Render then Plug-Ins then All if necessary.

This will render all plug-ins in the movie. After this is completed then Optimize Movie will work properly.

During rendering sometimes the system shows what's going on but usually the screen shows various frames or is black. The
rendered result is fine but I can't see what's happening during rendering.

Sorry. This is just the way it is. For us to display differently is not possible. Trying to do so is usually not possible and when it is it slows
the rendering process down significantly and we felt it more important to make the procedure faster rather than trade off speed for
cosmetics.

I added my Adobe Premiere compatible Effects but they do not show up OR they do not work.



We only support Ulead 2.5 to 5.0 compatible or Adobe 4.2 compatible effects. Older Adobe or Ulead Plug-In effects are not supported.
The older effects are probably not 32 bit effects and are not supported
(Adobe 4.2 DVEs: Due to very complex resource management for the customizing dialog box of Premiere we can support only those
DVEs which can NOT be customized eg horizontal flip and vertical flip.)

Does VM-Studio PLUS render audio?

No. PLUS does not support rendering of audio files, only video. When doing layering you must first protect the audio channels associated
with a video channel before deleting it. If you do not protect the audio channels the audio may be deleted when you delete a video clip.

Having Image shifting problems with rendered clips.

If the YUV installed then you need to run the DPR Calibrate program to remedy this problem. Unlike systems that have a YUV installed,
systems that do not will not have the DPR Calibrate program to fix this shifting problem automatically. Therefore, you will need to
manually correct this problem using the following procedure:

[DPR]
(Put the following line(s) under this section in the VM.INI file. If the section does not exist then create it.)

XSHIFT=x
(Where x= a positive or negative number of pixels to shift the image along the x axis.)

and/or

YSHIFT=y
(Where y= a positive or negative number of pixels to shift the image along the y axis.)

Background:

Solution:

Comments:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
New Panasonic Digital time code and Video Machine
05.11.98

Description/ Symptoms:

The time code used on the new Panasonic digital decks, such as the AG EZ-, NV DV- and NV DX- range is a digital time code. These
devices have a problem translating this digital time code into analogue time code. For this reason these decks are not currently
supported for use with Video Machine.

The (professional) AJD range of devices should work as long as RS422 control is used.

There are currently over 200 drivers available in the latest software (version 3.98a at time of going to print) for decks which are supported
with Video Machine. To see a full list please go to Tools > Device Setup and click the Install button (Please note that this will not give
you an up to date list of supported drivers unless you have the most recent software installed).

Background:

Solution:

Comments:

Software is available for download free of charge from the FAST UK web site at http://www.fusewire.com or the global FAST website at
http://www.fastmultimedia.com

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.
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FAST VMPC Technote
Hardware Suggestion for VM Systems
04.11.98

Description/ Symptoms:

FAST tries to test as many hardware components as possible. However, due to the nature of the fast changes in this market there is no
100% guarantuee that every new revision of any given component will work as tested with earlier revisions.

Motherboards:

SuperMicro P5MMA98
SuperMicro P5STE
SuperMicro P6SLA
Tyan S1684S
ASUS TX97 XE, mit Pentium MMX, 233MHz, ATX http://www.asuscom.de/de/produkte/P5/tx97-xe.html
ASUS P2L97 , Pentium II 300MHz, ATX (only two ISA slots) http://www.asuscom.de/de/produkte/P6/P2l97.html
ASUS KN 97 ATX , Pentium II 300 MHz http://www.asuscom.de/de/produkte/P6/kn97.html
ASUS P2B BX ATX, PII 400MHz http://www.asuscom.de/de/produkte/P6/p2b.html
Gigabyte GA586ATX2
Gigabyte 686 LX, mit Pentium II, 300MHz http://www.gigabyte.com.tw/GA686LX.html
Gigabyte 686 SLX, PII, 333MHz, ADAPTEC, (only two ISA slots!) http://www.gigabyte.com.tw/GA686SLX.html
Gigabyte GA-6 BXC, PII, 350Mhz, (3 ISA slots)
Gigabyte GA-6 BX, PII, Celeron A 300Mhz, (3 ISA slots)
QDI Legend I 440LX-ATX mit AGP, Pentium II 330Mhz http://www.qdigrp.com/eng/lx1.htm
Iwill PII NS, ATX mit Pentium II, 300MHz, ADAPTEC On board http://www.iwillusa.com/piins.htm

Please note: PENTIUM II MOTHERBOARDS REQUIRE VM STUDIO 3.3 WITH SR 3.98A

Graphics Cards:

Matrox Millenium I und II
Matrox Mystique
ELSA Winner 1000
ELSA Winner 2000 PRO/X ( 2 pieces needed for dualscreen)
ELSA Winner 3000 L ( 2 pieces needed for dualscreen) http://www.elsa.com
DATAPATH Twinfinity pro (one card for dualscreen, 2x 4MB) http://www.datapath.de
Appian J2 (one card for dualscreen)

DPR Hard Drives:

IBM DCAS-34330 4.3GB
IBM DFHS-34320 4GB
IBM DCHS-34550 4GB
IBM DCHS-39100 9GB
IBM DDRS-39100 9GB (9ES)
IBM DGVS-39100 9GB (9ZX)
IBM DGHS-39110 (9LP) 9GB
IBM DGHS-318200 (18XP) 18GB
http://www.storage.ibm.com/hardsoft/diskdrdl/prod/ultrastar.htm

Seagate ST32171N 2.1GB
Seagate ST32550N 2.1GB
Seagate ST34371N 4.2GB
Seagate ST15150N 4.2GB
Seagate ST19171N 9.1GB
Seagate ST39173N 9.1GB
Seagate Cheetah 34501 4GB
Seagate Cheetah 19101 9GB
http://www.seagate.com/disc/prodmatrix.shtml

Please note: Do not use U2W (LVD) harddisks with the DPR, since these types are not compatible with U-SCSI!
When you use adapters from 68pin to 50pin, please make sure to use active components.
In general the DPR can only address 32GB of a 2x18GB HDD pair.

http://www.asuscom.de/de/produkte/P5/tx97-xe.html
http://www.asuscom.de/de/produkte/P6/P2l97.html
http://www.asuscom.de/de/produkte/P6/kn97.html
http://www.asuscom.de/de/produkte/P6/p2b.html
http://www.gigabyte.com.tw/GA686LX.html
http://www.gigabyte.com.tw/GA686SLX.html
http://www.qdigrp.com/eng/lx1.htm
http://www.iwillusa.com/piins.htm
http://www.elsa.com/
http://www.datapath.de/graphics/twinfinity.htm
http://www.storage.ibm.com/hardsoft/diskdrdl/prod/ultrastar.htm
http://www.seagate.com/disc/prodmatrix.shtml


FAST can not be hold liable for the compatibilty of the listed hardware. We have no influence on other manufacturer's quality processes
and changes to their products. However, we try to update this list on a regular basis to reflect changes known to us.

Background:

Solution:

Comments:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
Drop Frame vs. Non Drop Frame with VM
30.10.98

Description/ Symptoms:

If you encounter the message "The TC format reported by the player does not match the format specified in reel (PAL/NTSC or
DF/NDF mismatch)", make sure that you have selected Drop Frame (DF light green) if your source tape was recorded in the drop frame
mode (consult your Camera or VTR manual to determine if your source tape was recorded in Drop Frame (DF) or Non Drop Frame
(NDF)).
If it was recorded in Non Drop Frame (NDF) leave (DF) light grey (disabled) in the Group Settings menu. The selection (DF or NDF) in
the REEL GROUP MUST match the mode that the source tape was recorded in. You can check if your (NDF/DF) mode is correct by
selecting the arrow key in the group and choosing Edit Group, there you will see if the (DF) button is green or grey (Green means Drop
Frame (DF) Grey means Non Drop Frame).

Background:

Solution:

Comments:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
Black and White Picons
28.10.98

Description/ Symptoms:

There are Two main reasons why your picons may be in black and white in you project manager.
1. You have not selected the proper decoder in the Tools > Device Setup > Name of Machine > Decoder > Choose S-Video or
Composite (which ever applies).
2. Your hardware settings are incorrect. Try using D000 as your Memory Base in Tools > Hardware setup.

Background:

Solution:

Comments:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
IRQ or I/O Problems
28.10.98

Description/ Symptoms:

If you experience the message BAD I/O or NO INTERRUPT while try to set up your hardware.
1. Go to Start > Settings > Control Panel > Device Manager > Properties > Locate open IRQ 11,12,14 or 15 (if it is available
the number WILL NOT show up on this list, if all of these numbers have devices attached to them, then decide which ones you
can disable or eliminate from your system) > write down open IRQ.
2. Go into your BIOS (call motherboard manufacturer if unfamiliar with BIOS) > locate PNP/PCI configuration > Set configuration
to manual > highlight the open IRQ (you wrote it down in section 1) > select ISA/Legacy > Save to CMOS and Exit
3. Try to re-launch VM program > choose Custom > Use I/O Base 100 > Memory Base D000 > IRQ - which ever one you set to
ISA/Legacy

Background:

Solution:

Comments:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
Tip for keying Crystal 3D Impact Pro graphics with VM
29.10.98

Description/ Symptoms:

After making graphic in 3D impact Pro > go to Render > Set Background > Choose Select Color > choose Black >go to Animation >
Assign Motion (assign any since you are just using frame 1) > Choose Make Movie > Choose Targa Sequence under "Type" >
Choose 32 bit (8 bit alpha) > Name the folder choose Select Folder > Path your files to the VM Studio\Images folder > Hit OK >
Launch Video Machine > Go to Group > New Graphics Group > Name Group > Load Graphic > Find your Graphic in the images folder
and hit OK > Place graphic on timeline and dissolve to it to make it key.

Background:

Solution:

Comments:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
DSR 60 with VM
12.10.98

Description/ Symptoms:

If you experience problems with your DSR-60 performing an edit (the machine will try several times, but stops at the edit point). Go to
Tools > Device Setup > Highlight the DSR-60 > Choose Setup and un-check "Can Compensate".

Background:

Solution:

Comments:

Device Note for DSR-60

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
Error: "Can not find the requested search position"
08.10.98

Description/ Symptoms:

When editing with prosumer decks (like e.g. Panasonic AG 1970-1980) and you get the message "Can not find requested search
position" (or something to that effect), try going to Tools > Rec Control > Choose the Pocketknife > VITC Test. Most likely you have
not enabled the VITC in the device setup and you will get the message "No VITC present". You must then enable this by Tools > Device
Setup > Select the record deck > setup > VM TC > check "Use VM TC when timecode board missing".
In additon please make a first edit. Please put in a S-VHS tape into your deck and go to Tools > Output setup > Select the VITC
button > 1st edit and stripe the whole tape with VITC.

Background:

Solution:

Comments:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC\DPR Technote
DPR - Backing up DPR Video/Audio Files
15.04.98

Description/ Symptoms:

Introduction:

It is important to back up DPR data as a means of saving unrecoverable video and audio files that are generated during rendering or
from live recorders, for example. Our experience has shown that it doesn't make much sense to make a Backup of DPR data digitized
"normally" from tapes since the back-up process takes longer than it would to redigitize the material from tape.

Backup Software Test:

Hardware:
- PC with Adaptec 2940 SCSI host adapter
- DAT streamer
- Video Machine with DPR

Programs:
- Windows 95
- SEAGATE Direct Tape Access Ver. 2.05 (latest version 3.0, price approx. DM 120)
- DPR-Manager 1.2 (VM-Studio 3.3 / 3.98)

Note:
It is easy to install the streamer software (Direct Tape Access). If you follow the installation routine, your PC will be rebooted at the end of
the routine, the DAT will be recogized as a device and registered in Windows as a drive.
You can then use the SEAGATE Toolkit to format a DAT tape. A quick formatting routine (Quickformat) is sufficient for the DPR and lasts
about 10 minutes for 2GB tapes.
Since DPR data is already compressed, additional hardware or software compression is not recommended.

Now you can start the DPR-Manager and copy the DPR files onto the DAT with standard drag&drop operations.
You can also select several files or directories to be copied. But, you need to make sure that you never attempt to copy more than 2GB
at any one time (Windows has a 2GB limit - in this case, FAT32 file systems are no help at all!).

The approximate values you need to remember are than only 1.5GB fit onto a 2GB tape and only about 7GB fit onto an 8GB tape
(because of error correction).
It takes about one hour to transfer one gigabyte!!! - (regardless of the DAT)

Note:
The company Tapedisk also offers another back-up solution.
However, this program is somewhat more difficult to configure. We prefer the SEAGATE solution.

Background:

Solution:

Comments:

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR



OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



FAST VMPC Technote
DPR / Harddrives - Troubleshooting
16.03.98

Description/ Symptoms:

Contents:

1. Difficulties that can arise during installation

A. Hard disk jumper settings
B. DPR jumper settings
C. Checking the entries in Dpsys
D. Check cabling
E. Testing/formatting individual disks
F. Tools

2. Difficulties that can arise during use

This section is a list of the most common error messages and corresponding solutions.

1. Difficulties that can arise during installation
Please check the following items if error messages or any other anomalies occur during or directly following installation:

A. Hard disk jumper settings
Check the jumper settings on the hard disks:

All connected disk pairs must be terminated. If you're using more than one pair of disks, terminate the last pair,
meaning the pair furthest from the DPR. If the SCSI cable extends beyond the last device, it does not have to be
terminated, rather an external terminator has to be connected to the end of the cable.

■   

The Parity Check should be disabled for all disks.■   

Each pair should be assigned its own singular ID. Both of the disks that make up a pair have the same ID.■   

The Autostart feature should be enabled for all disks (if available).■   

Termination Power: If one or no more than two pairs are connected, Termination Power should not be enabled for
any of the disks. If more than two pairs are connected, Termination Power (to bus) can be enabled for the last pair.

■   

Please refer to your drive documentation or ask your dealer which jumpers on the disks need to be set to meet these
requirements.

B. DPR jumper settings

If one or several SCSI-disks are connected, all three jumpers on the DPR must be enabled. For more information, please
read TN 23.

C. Check the entries in the Dp.sys file
After running the "DPR Configuration" program (see also TN 23), the config.sys file is modified. The change causes the
system to recognize the disks the next time the program is started. If the disks are not recognized, the entry in the
config.sys file may be missing or incorrect.

The following information may help you check the entry:

To call the Dp.sys file, use the following command structure:

Device = [path] \ dp.sys -i:.... �w:..... �p: ......

The parameters �i:, -w: and �p: represent:

-i: ID numbers of the hard disk pairs and the Wide SCSI HDD.



Allowed values: 0, 1, 2, 3, 4, 5, 6 (for Wide SCSI: 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E)
-w: Boolean parameter that defines whether it is a Wide SCSI hard disk. 0 is a Fast SCSI-2, 1 is a Wide-SCSI.
For each ID number allocated with the parameter -i:, you must define whether the disk is a Wide-SCSI or a Fast SCSI-2..
-p: Port address (in hexadecimal) of the DPR

For example:

Entry in Config.sys file for two hard disk pairs, one with ID 0 and one with ID 1:

Device=dp.sys -i:01 -w:00 -p:310

Entry in Config.sys file when using one pair of Fast SCSI-2 hard disks with ID 0 and one Wide SCSI hard disk with ID 1:

DEVICE=dp.sys -i:01 -w:01 -p:310

Entry in Config.sys file when using two Wide SCSI hard disks with ID 0 and 1:

DEVICE=dp.sys -i:01 -w:11 -p:310

The ultimate scenario: 7 pairs of Fast SCSI-2 and 8 Wide SCSI hard disks:

DEVICE=dp.sys -i:0123456789ABCDE -w:000000011111111 -p:310

D. Check Cabling

Another frequent source of error in the SCSI configuration are the cables between the DPR and the drives. Should
problems arise, reduce the amount of cabling to a minimum.
For example, external drives can be connected internally by means of a flat conductor cable thereby eliminating connectors
and adapters as potential sources of error. If this eliminates the error, gradually check your cabling.

E. Testing / formatting disks individually

If you've connected several pairs to your set up, it is important to be able to locate the pair or individual disk that is the
source of error.

To do so, before you begin working, every pair should be connected individually to the DPR. Make sure to pay
attention to the jumper settings and the dp-sys entries.

■   

Should one of the pairs be defective, connect each disk individually to an SCSI controller (e.g. Adaptec 2940) in
order to determine whether only one of the two disks is defective.

■   

Adaptec controller give the option of using the function "Verify Diskmedia" that can be called from SCSI Bios in order
to review further information about the disk and to locate possible errors or defects.

■   

If no error message appears, try and format the drives. If you can't format them, the drives are probably defective.■   

This testing procedure detects almost every hardware defect.

F. Tools

The DPR Manager in the VM-Studio program group provides a number of tools that can be used to test the DPR and DPR
drives:

"Check Integrity of DPR Drive" runs a test on the selected DPR drive and should an error be detected, gives you the
option with "Repair" of fixing it. If this test doesn't work, you need to reformat the DPR drives.

"Check DPR Memory" tests the DPR buffer memory and notifies you of any errors in this sector. In this case, you need to
contact FAST Support or your dealer.

"Search SCSI for Devices" searches for all connected DPR drives. Check whether all connected disk pairs have been
recognized.



 

"Display DPR Info" lists information about the DPR and the selected drive.

"Format DPR Drive" formats the selected drive. A dialog box offers you the options Optimized, 256k and 512k. These
parameters refer to the block size to be used to format the hard disk (256 kilobyte/512 kilobyte). If you choose Optimized, a
Speedtest will be conducted with both block sizes to automatically select the size for the fastest formatting.

The VMSTUDIO/DPR directory contains other tools that are useful for troubleshooting and repair (see also TechNote 29).

Useful tools have been grouped to solve problems with the drives:

All of the following tools are DOS programs and are run in the VMSTUDIO/DPR directory:

1. DPTEST.EXE tests whether all components of the DPR hardware and the FAST video bus connector function properly.
Which test is actually run depends on the parameters in <mode>.

Important: dptest without parameters assumes that Video Machine is initializied to 300. If the address is set to 100,
the following message appears:
"DSP Write Timeout VideoMachine doesn't answer."

dptest <dpr-adr> <log-file> scsi <vm-adr> <TV Stand>

We recommend initializing VM with vminit -i:300 before running DPTEST!

<dpr-adr> refers to a port base address for the DPR
<log-file> refers to an ASCII file to which the test results are written
<mode> specifies which functions should be tested:
<TV Stand> PAL or NTSC

scsi Note! This test runs a read-write test of connected drives. Data on the disks may be overwritten (this will
generally only happen when the disks are very full [+90%]). The same tests are conducted as described under "No
Entry". However, the signal frequencies are not built up. Communication between the DPR and connected SCSI devices
are tested without using the dp.sys driver.

If Video Machine is allocated to an address other than 300, and if dptest is run without parameters, use the
following command:

dptest 310 test.log none 100 PAL

This will run a "normal" dptest of the DPR at address 310, the logfile 310.log and test VM at address 100 in PAL.

2. DPFORMAT.EXE formats drives connected to the DPR.
dpformat <drive> <param>

<drive> defines the drive letter of the drive(s) to be formatted
<param> defines how the drive is to be formatted:

-b:<block-size> determines the block size during formatting. The choices are 256 kB or 512 kB (e.g., dpformat d: -b:512)

-t tests drive(s) performance and determines the optimal block size. Formatting is then conducted with the optimum block
size so determined.

-s causes a non-destructive speed test to be conducted (read-only test)

-L conducts low-level formatting that recognizes defective blocks and marks them so they will not be used.
Note: after low-level formatting you should run a "normal" formatting operation
(Parameter �t).

-l:1 �t conducts a "boot-sector format" which only rewrites the boot sectors on the disks. None of the data on the disks is
lost. Note: once this command has been executed, a message appears that all data will be lost. Ignore this message. By
entering this parameter properly, no data will be deleted or lost (e.g. dpformat d: -l:1 -t).

No Entry Formatting will be conducted with a default block size of 256 kB



3. HDDINIT.EXE initializes the DPR drives (as of Version 3.98)

hddinit <dpr-adr> <vm-adr>

<dpr-adr> the DPR port address
<vm-adr> the VM port address

You can add this program to your Autoexec.bat in order to ensure that the DPR disks are initialized thoroughly. This is
particularly recommendable if the error message "Drive appears not to be formatted" appears during the DOS-based part of
the installation routine.

2. Difficulties that can arise during use:

Your system has run without problems for a certain period of time and suddenly errors begin occurring even though you
haven't changed the configuration in any way.

This section lists the most common error messages and their possible solutions.

"HDD hangs"/ "HDD too slow"

If one of these error messages appears, start by checking the compression rate first that you've assigned the clip currently
being used. If the compression rate is smaller than 1 to 10 (e.g. 1:5 or 1:8), chech whether the drives are able to keep up.
To test the situation, digitize the clip in question at a considerably higher compression rate (e.g. 1:20). If the error no longer
occurs, you drive is too slow for the previously set compression rate.

If this is not the case, the next step is to test the drives:

Run the "Check integrity of DPR Drive" test described under "F.Tools".

If no "Lost Clusters" are found, please read all tips under 1 (A bis F).

"Drive appears not to be formated"

If this error message appears, you need to determine which of the two scenarios described below has occurred.
The error occurred once or rarely and is fixed by making a "cold start". You can also thoroughly initialize the drives
by adding the hddinit.exe tool to the digital.bat. (see also readme.txt in software Version 3.98)

■   

If the error persists, make sure that the drives are activated as soon as the system comes up and follow the tips
under I (A. bis F).

■   

"Drive could not be mounted"

The error occurred once or rarely and is fixed by making a "cold start" or by adding the hddinit.exe tool to the digital.bat to
make sure the drives are thoroughly initialized. (see also readme.txt in software Version 3.98)

Otherwise, check items A to F under 1.

"Dp.sys comunication failed"

Check items A to F under 1.

"DPR FAT BAD"

Run a boot-sector format.
Enter the following command at the DOS prompt in the VMSTUDIO/DPR directory:

dpformat [drive letter]: -l:1 �t



If nothing happens, run a standard format operation or a low-level formatting routine (see "F. Tools").

"Drive seems to be write protected"

Check items A to F under 1.
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FAST turnkey DPR drive integration
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Description/ Symptoms:
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I. Basic Information about Hard Disks
A. What kind of hard disks can I use with the DPR?

As a rule, all SCSI-2, Ultra-SCSI, Wide-SCSI or Ultra-Wide SCSI hard disks can be connected to the DPR.
B. Requirements:

1. DPR hard disks should run at a minimum of 7000 rpm.
2. A guarantee of at least three years is best.
3. Ultra-SCSI or SCSI-2 hard disks are connected in pairs. You need two identical drives from the same manufacturer.
4. Hard disks with a capacity of more than 16.5 GB are not recommended since no more than 33 GB can be managed on a logical
DPR drive (two drives 16.5 GB).

NOTE: Drives that will not allow you to disable the parity check cannot be used with the DPR!!
C. Which one is better: (Ultra) SCSI or (Ultra) Wide SCSI?

1. Wide SCSI hard disks can be used with the DPR. However, you will need a special cable that can be ordered from the FAST
Fulfillment Center (http://www.fastmultimedia.com).
2. It is not necessary to use AV-modified drives for the DPR since the DPR has its own buffer memory (standard size: 10 MB).

D. FAST recommends:
1. Using the SCSI-2 connections on the DPR since it supports the highest data transfer rates.
2. Use pairs of SCSI-2 or Ultra SCSI drives.
3. Ultra-Wide-SCSI drives can be connected with the corresponding adapters (50-pin SCSI-2 male connector to 68-pin
Wide-SCSI male) in pairs to the SCSI-2 connection.

II. Preparing the Hard Disks and the DPR

A. Jumper settings / Termination:
As a rule: An SCSI chain must be terminated at both ends, meaning that some form of termination must be added to both ends of
the cable.

B. Jumpers on the DPR:
All three jumpers on the DPR should be set (enabled). Should you decide to use a different cabling variant, please refer to the
manual or the help file for the correct jumper settings.

C. The following jumpers must be enabled on the drives:
1. The Parity Check must be disabled on all drives.
2. The last pair in the SCSI chain must be terminated (see Fig. under 3) or the end of the cable extending from the last pair
(external terminator required).
3. The auto start should be enabled (if available).
4. Each pair of disks must be assigned a separate ID (see also Fig. under 3)

Please refer to the drive documentation to make sure which jumpers on the drive should be enabled to meet these four requirements.
III. Installing the hard disks in your PC

A. Ventilation and thermal problems:
1. Video hard disks are generally subjected to wear and tear that manifests in the production of heat.

http://www.fastmultimedia.com/


 

2. We recommend making at least one blower available for each pair of drives.
3. When using two or more drives, an external case with separate cooling and power supply is recommended.

B. Cables:
Use high-quality cables whenever possible. To ensure that the drives connected externally function properly, high-quality
double-shielded SCSI cables should be used.

C. Cabling Options:
As a rule, the number of adapters and separate connections in the cabling scenario should be kept to a minimum. For example:
Connect an external case directly to the DPR by means of a flat conductor cable. The flat conductor cable must be fed out through
one of the slot covers in the PC case without using an accident-sensitive adapter. Admittedly, this is not the most elegant solution,
but, from a technical standpoint, it is the best solution and in our experience creates the fewest problems.

IV. Configuring the DPR Software:

A. Starting the system for the first time after connecting the drives:
1. After connecting the drives to your set-up, start Windows and call up the "DPR Configuration" program in the VM-Studio
program group.
2. Click the button "Scan SCSI drives".
3. Once you have done so, your drives should be recognised by the corresponding ID address (If not, retrace steps already
listed). Click OK and reboot.
4. Once you have restarted your system, the DPR will recognise your drives, and they can now be formatted.
5. In a few rare cases, Windows 95 may not start if unformatted disks are connected to your system. If this happens, the drives will
have to be formatted under DOS (consult manual).

B. Formatting:
1. Go to the DPR Manager and select "Format DPR Drive" under Tools.
2. The dialog box gives you the options Optimised, 256k and 512k. These parameters define the block sizes to be used to format
the drives (256 kilobytes/512 kilobytes).
3. If you choose Optimised, a Speed test will be conducted with both block sizes to automatically select the size for the fastest
formatting.
4. Once you have finished formatting the disks, they are ready to record video.

V. Basic DPR Information:

A. Managing DPR Drives:
1. DPR drives should be formatted at regular intervals, specifically before beginning a new project. This prevents data artefacts
from collecting as well as fragmenting of the disk.
2. As a rule, DPR drives should not be used to more than 80% of their actual capacity. The fuller the disks are, the slower they
become hindering sufficient performance.
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FAST VMPC Technote
Calibrating LanC and Edit Control Devices
07.11.97

Description/ Symptoms:

Calibrating your machine in this way may remedy a constantly recurring editing error that has resulted in black or missing frames.

Machines that are controlled by the LanC or Ectrl protocols may exhibit random inaccuracies during the editing process as a result of
their mechanical drive properties. Errors of this nature cannot be remedied by this calibration.

Depending on the timecode used, you will need to adjust the cabling. If you decide on VITC, the video output of the recorder has to be
connected to the Video Machine video input connection since VITC is fed from Video Machine via this line. Naturally, this input also has
be entered in Device Setup to match the cabling.

The decisive values that you can change in order to optimize the editing process are to be found in the drivers of the respective devices
in VM Studio under Tools in Device Setup. Choose the device to be calibrated so that it is framed in black and then click SETUP.

Before you can complete the following procedure, your devices must be installed properly and a tape must be inserted into your recorder
that has already been striped with timecode.

You can now begin calibrating the recorder since a recorder's frame-accurate editing capabilities are a prerequisite for the rest:

1. The first value to be determined is the STILL DELAY (only for Edit Control devices). The STILL DELAY determines the point in time at
which the pause command is sent to the device in order to stop it at a specific position.

· Click the REC button above the Timeline to open the "REC Control" window. Click the mouse at the very top of the timecode box, enter
the value 00:02:00:00 (2 minutes) and enable GOTO.
· Video Machine searches for the entered position.
· Read the timecode value that was reached and compare it to the desired value (00:02:00:00) and calculate the difference by subtracting
the desired value from the displayed value. In your calculation, it is important that you take into account the appropriate sign (plus or
minus)!

For example:
PAL--The displayed value is 00:01:59:23. You calculate: 00:01:59:23 - 00:02:00:00 = -00:00:00:02. You should be aware of the fact that
the timecode display represents hours:minutes:seconds:frames. In this case, 25 frames per second are counted. The possible values are
00 to 24.
NTSC-- The displayed value is 00:01:59:23. You calculate: 00:01:59:23 - 00:02:00:00 = -00:00:00:07. You should be aware of the fact
that the timecode display represents hours:minutes:seconds:frames. In this case, 30 frames per second are counted. The possible
values are 00 to 29.

· Repeat the test at least five times and calculate the mean value of the inaccuracies. Multiply this value by 2 and add it to or subtract it
from (depending on plus or minus sign) the default value for STILL DELAY in DEVICE SETUP.

2. The next value to be tested is the REC START SHIFT. Modifying the REC START SHIFT delays the beginning of the devices'
recording.

· Place a graphic image (e.g. red.vm from the VMSTUDIOS\IMAGES directory) onto track V1 in the Timeline (for a duration of 30 sec.),
place a hard cut at the beginning and record the clip.
· Place a second graphic image (e.g. blue.vm) onto track V2 precisely 15 seconds after the beginning of the first graphic with a duration
of 5 seconds; a hard cut proceeds at this point from V1 to V2. Then record the range of the second clip by marking it in the Timeline and
clicking the Record button.
· Open the REC Control box again and search for the point at which the red graphic is seen for the last time before the beginning of the
blue graphic image (or a black frame).
· Note the exact timecode at this position and again calculate the difference between the displayed and the desired position by
subtracting the desired position (to be read from the Timeline) and the actual position.
· Repeat this second calibration procedure at least 5 times and determine an average value from the inaccuracies detected. Subtract it
from or add it to (depending on the sign) the REC START SHIFT value in DEVICE SETUP.

3. The next value to be checked is the EDITING DELAY. Modifying the EDITING DELAY will change the beginning and end of the
devices' recording.

· About ten seconds after the long red graphic image in test 2, alternate five red.vm and five blue.vm clips in the Timeline and join them
with hard cuts.
· Record the first two clips of the clip sequence by marking them in the Timeline and clicking the Record button.
· Open the REC Control box again and search for the point at which the first graphic image begins.
· Make a note of the timecode value at this point and calculate the difference between the displayed and the desired position by



 

subtracting the desired position (to be read from the Timeline) from the actual position displayed.
· Mark the two subsequent clips, record them, proceed with the next two; and from all these tests, calculate the average of the
inaccuracies.
· Multiply this value again by 2 and add it to (or subtract it from) the EDITING DELAY value in DEVICE SETUP.

4. The last value to be checked is EDITOFF DELAY. Modifying the EDITOFF DELAY changes the end of the devices' recording.

· Again, as you did above, add five alternate red.vm and five blue.vm files 10 seconds after the last clip and join them with hard cuts.
· Record the first two clips by marking them in the Timeline and clicking the Record button.
· Open the REC Control box again and search for the point at which the second graphic image ends.
· Make a note of the timecode value at this point and calculate the difference between the displayed and the desired position by
subtracting the desired position (to be read from the Timeline) from the actual position displayed
· Mark the two subsequent clips and record them. Proceed with the next two clips, etc. From all these tests, calculate the average of the
inaccuracies.
· Multiply this value again by 2 and add it to (subtract it from) the EDITOFF DELAY value in DEVICE SETUP.

5. Finally, you will look at a setting that can marginally slow down the editing process, but that may in some cases actually increase the
accuracy of the edit should that be necessary (e.g. with Sony's HDR 1000VC).
The function "NO REPOSITIONING OF CONSECUTIVE REC" causes the recorder to stop in pause mode after a scene has been
recorded until the next clip is prepared. In this scenario, the recorder starts up in record mode after the pause mode is released. If this
function is not enabled, the recorder returns to stop mode after the recording, rewinds a bit, and repositions at the beginning of the preroll
position where it then waits in pause mode until the next scene is set up.
We recommend using the option "NO REPOSITIONING OF CONSECUTIVE REC" since in addition to making the editing process faster,
there is also less mechanical wear on the devices. However, if you are dissatisfied with the editing results provided by your recorder, we
do suggest that you disable this option.

The recorder is now calibrated and, within the scope of its actual performance capacity, will record as accurately as possible. We can
now go on to take a look at the player. The following description assumes that the STILL DELAY was also calibrated for the player (only
for Edit Control devices) as described above. Instead of the REC Control box, when calibrating the player, you will use the Clip Editor.

6. The only value that is decisive for the accurate playing of clips from the player is PLAY DELAY. Modifying PLAY DELAY shifts the
beginning of the insert. It is very easy to calibrate this value.

· At the end of the Timeline, alternately add the same video clip five times with an interval of 10 seconds in between. You should use a
clip that was defined for the player to be calibrated.
· Mark the clip and record it with the calibrated recorder. Open the REC Control box and search for the point at which the video clip
begins.
· Make a note of the timecode value at this point and calculate the difference between the displayed and the desired position by
subtracting the desired position from the actually shown position.

Repeat this process by marking and recording the individual clips one after the other. Calculate the average value from the inaccuracies
and multiply this figure by 2 and add it to (subtract it from) the PLAY DELAY value in DEVICE SETUP.

Should it be necessary, you can repeat this calibration of the player for a second player if you use two devices.
You need to be aware that in all of these tests random inaccuracies of +/- 1 frame can occur. This random shift cannot be remedied
through this type of calibration. Moreover, it may confuse the results of the tests presented above. That is the reason why all tests should
be conducted at least five times in order to exclude the element of change by determining an average value. If you still don't feel you can
trust your test results, it really does make sense to repeat them several times.

It is recommended to use the default settings for all other options in Device Setup.
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FAST VMPC Technote
Luma and Chroma Keying with VM/DPR
07.11.97

Description/ Symptoms:

You want to use VM and the DPR to make parts of a video clip transparent, and to make another video source visible through the
transparent parts.
VM lets you use the Timeline to change the transparency of color or brightness ranges of a video clip. To do so, you can use the
following procedures:

1) Place the background clip (the clip that is to appear in the areas of the clip that have been made transparent) onto track V1.
Place a foreground clip (the clip that you want to make transparent in certain areas) at the appropriate place in track V2, but below the
clip in V1.
Cut to the clip in track V2 with a hard cut. Open the DVE Editor by double-clicking the hard cut. On the left side of the dialog box is the
"Keying" option. Enable this option. The window that now opens contains settings to manipulate the luminance (the brightness values)
and the chroma key (the color values.) Best results are achieved with a luma key. If you have decided on chroma keying, select the
button next to the word "Chroma" (it turns green when selected) and use the arrow below and to the right to select a color range that you
think best corresponds to the color area of the foreground clip.

Save the effect before closing the box.

To be able to see what the effect will do, you will need to run a preview. You will not be able to view the effect by scrubbing with the
mouse across the Timeline.

Now that you have modified the hard cut, you have assigned a key to the entire V2 track. You will thus have to reverse the effect after the
clip has ended.

To reverse the effect, mark the hard cut, press the CONTROL key and use the mouse to drag the effect to the end of the clip and onto
track V1. Open the DVE Editor again and select the Keying option. Click the "RESET" button. When you now save the effect, the keying
option is disabled for the rest of the movie.

However, to get the best possible results, you need to watch a few things. The key comes out best when you work with a neutral,
unicolor background. Professional editors prefer to use blue and green (i.e. the blue box and the green box.) Make sure that the
background is uniformly lit to prevent shadows from obscuring a clean keying effect.

2) If you are working with the DPR, you can optionally run a preview of the clip you want to key as you select the color or brightness
ranges. The advantage of this procedure is that you can actually see whether you have defined the appropriate key area.
To do so, you need to open the Clip Editor for the foreground clip in the Timeline with a double click. Select the "Swiss Army Knife" icon.
In the subsequent dialogue box, you will find the "LOOP PLAY" function. This option plays the clip as a continuous loop and constantly
feeds it to the output. Leaving the Clip Editor open, edit the hard cut as described above. The only difference is that you will now see a
direct preview of the keyed clip on your output monitor.

3) The following options are available for inserting subtitles or a logo as graphics: Use a graphics or animation program such as
Photoshop or Crystal Graphics Flying Fonts to create a graphic image that includes an alpha channel (32-bit TGA graphic). This
additional information defines which areas of the picture will be visible or transparent later. Video Machine is able to read this information
and to display the specified areas either solid or transparent accordingly.
If you don't want to work with an alpha channel, you also have the option of creating a graphic image in the VM Titler. To do so, select
the "Print" option in your graphics program and choose the VM Title Driver from the listed options. Under the "Mapping" option you can
now define the color areas to be displayed transparent. As the direction of travel you should choose "Still". With "Save As" you can print
the title to Video Machine.

4) If you are working with VM Studio PLUS and want to use the keying option with Multilayering you need to know that the VM keying
cannot be rendered.
In order to be able to key clips and graphics anyway, you will have to use a key filter. These filters are available from Boris FX 3.0 from
Artel Software Inc., for example.
If you have installed this program and selected the plug-in with the "Add" function under "Render Options", specifying the plug-in in the
Boris Settings directory, the new effects group named Adobe FX and a new entry in your Filter window will be created. You will only find
one entry for Boris FX in the Filter and Effects windows because Boris FX lets you create individual filters and effects.

In order to be able to work with a key filter, double-click the clip to be made transparent while simultaneously pressing the shift key. In the
Video Filter window that opens, choose Boris FX and open the Boris Settings by click "add". In the window that opens, choose the Filter
option. This opens another window that contains both a control and a preview window. Next to the "Type" option you will find a folder
labeled "none". Click the folder to view a list of the appropriate filters. Make your choice; chroma key for example.

You will now be given different options regarding the settings for the filter. You can also simply choose the "colors" folder and click the
"pipette" icon. This lets you choose the color area in the preview window. In order to check the results of your keying effect, use the filter
controls.



If you like the results, close this window and the next one by clicking OK.

You now need to render the clip marked in red in the VM Timeline with the "Render Filter" function.

Background:

Solution:

Comments:

VM Studio Manuals
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FAST VMPC Technote
How can I use the DPR to produce video CDs? (DPR to AVI conversion)
05.11.97

Description/ Symptoms:

You have used the VM/DPR to create several clips and now want to use these to produce an AVI or an MPEG-1 file in order to
burn it onto a CD, for example.

Background:

In producing a multimedia CD, it is important that the CD can be played by all kinds of PCs, regardless of the brand of hardware
used. To make this possible, the video data has to be stored in formats that meet this requirement, such as Intel Indeo-coded AVIs
or MPEG-1 files.

Solution:

There are three ways of producing AVI files from DPR clips:

1. Output as an AVI file with Media Mania Broadcast Version 2.0 or VM Open (both from AIST):

The Media Mania Broadcast software (Version 2.0) lets you read DPR clips directly from the DPR hard disks (for more
information, please refer to TechNote 40) and save them in different formats on the system hard disk. The available formats are
listed under File>Render Setup.

2. Output of single frames with 'Split Clips to Images'

You also have the option of breaking DPR clips down into a sequence of single frames in VM-Studio by using the function "Split
Clips to Images" and then storing them on the system hard disk. The sequence can them be converted into an AVI file by an
editing software application like Ulead's MediaStudio or Adobe Premiere. The new file can then be played by software.

3. Analog output and simultaneous digitizing with a video capture card

A third option assumes your system configuration includes extra, separate hardware (a video capture card) like FAST's Aviator
Speed product to produce AVI files.
This version is also the fastest (and probably most affordable) way of creating (Indeo) AVI files. To create the file, Video
Machine's video output line is connected to the input of the video capture card. The clip is then played in Video Machine and the
capture application's recording feature is started. AVI files produced in this way do not require specialized hardware for
playback. We recommend installing Aviator in a separate computer, but have also tested the board in a setup that had everything
installed in one PC.

There are two ways of creating MPEG-1 files:

1. Using software to convert AVI files into MPEG
In this process, we assume that the procedure described above was successfully used to create an AVI file.
The AVI files can be converted with programs such as "Xing MPEG Encoder" or the "Ulead MPEG Converter". Admittedly, this
can be somewhat complicated and time-consuming. Method 2 is simpler and faster (but also more expensive).

2. Creating MPEG files with MPEG Encoder Hardware

The second and considerably more elegant, but also more expensive option is briefly described. In this scenario, additional
hardware installed in a second computer is used to create the file.
MPEG Encoder Hardware (e.g. from Optibase, http://www.optibase.com) makes it possible to create MPEG (real-time) files
rapidly without having to put up with prolonged computing times.

Comments:

http://www.optibase.com/


n.a.
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FAST VMPC\DPR Technote
TIPS for working with Media Mania and VM/DPR
18.02.97

Description/ Symptoms:

TIPS for working with Media Mania and VM/DPR

Media Mania Broadcast Version 2.0 lets you add video clips produced with the DPR as well as output an animation as a DPR file.

The following basic settings must be taken into account:

1. Import DPR clips

To load a DPR clip in Media Mania, go to "Object" -> "New Object" -> "Filmstrip Icon" -> "Continue"

A dialog box will appear. Select the DPR HDD first, and then the clip. Confirm with "Continue".
Choose "simple.bhv" + "Continue"

Choose "Proportional" in the following dialog box and confirm with "OK".

The box "Film Properties" opens.
Since the DPR only works with fields, click the "Fields" option and choose "Even/Odd" and confirm with "OK".

The program then loads the chosen clip.

2. Output as DPR clip

Proceed as follows to save an animation once it is completed as a DPR clip: go to "File" -> "Image Resolution Settings".

Change the following settings in this dialog box:

Format: Digital Video Recorder
Compression: //// FAST
Type of mass storage: hard disk

Width: 786
Height: 576

Fields: Even/Odd

Quality: this setting corresponds roughly to the compression rate of the VM/DPR, meaning that 100% would be a 1:1 compression.
Depending on HD capacity and performance you should enter the following values: e.g. 98%= 1:3; 97%= 1:5; 95%= 1:8.

The new values can be saved for later use. Enter a name in the line "Pattern", e.g. DPR, and then click "Add".
For subsequent actions you only need to click this name, and the settings will be retrieved. Quit this box by clicking "OK".

Now, to write to the DPR HDDs, choose "File" -> "Image Resolution".
Enter the DPR drive as the target drive in the following box and then specify a reel for the animation to be written to.

Please note the file extension in naming the files: e.g. dpr00010.!v
The clip to be calculated should always be saved to an existing reel.

Make sure that the settings listed in the small box are what you need.
Once this process is started, Media Mania begins rendering an animation for storage on DPR disks.

Once the program is completed, open the VM and DPR Manager and copy the reel containing the completed clip into a VM project.

Background:

Solution:



Comments:

Manual Media Mania
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FAST VMPC\DPR Technote
DPR: Importing AVI Files/ Video Machine DPR System
23.12.96

Description/ Symptoms:

Background:

Use the following steps to import an AVI file

Solution:

1) Open the Group menu in VM program choose,Create an animation group.

2) Give a name and number for the reel, in the group settings. then click Ok.

3) Click on the disk icon in the reel group that you have created.

3) Click on selection call importing animation files.

4) From the import movies menu, select the directory and file name. then click Ok.

5) In the Animation group settings , select the reel, to which the AVI file clips is to be placed.

6) Option; compression ratio can be selected for the DPR setting at this point.

7) Click on the select icon. Graphics editor option will displayed. make selections , then click, Ok. Then animation will be rendered.

Thanks to ///FAST US
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FAST VMPC Technote
Starting PCs in Different (DPR) Configurations
31.10.96

Description/ Symptoms:

You want to start your VM-DPR system without the DPR, meaning that you want to prevent the drivers dp.sys and the batch file
digital.bat from being executed.
As of DOS version 6.0, you have the option of starting the operating system in different configurations. To do so, modifications
are made in the files config.sys and autoexec.bat which, among other things, cause a start menu to appear when the PC is
powered up that contains a list of optional configurations. This feature is also included in Windows 95!
The following example lists several of the options:

1. Without DPR
2. With one DPR drive
3. With two DPR drives

It is assumed that the DPR uses the I/O port address 310 and that the first DPR drive uses SCSI-ID0, and the second SCSI-ID1.

config.sys:

[MENU]
menuitem=NODPR
menuitem=ONEDRIVE
menuitem=TWODRIVES

[NODPR]

[ONEDRIVE]
REM ///FAST Multimedia AG (C) 1995
DEVICE=C:\VMSTUDIO\DPR\DP.SYS -i:0 -w:0 -p:310

[TWODRIVES]
REM ///FAST Multimedia AG (C) 1995
DEVICE=C:\VMSTUDIO\DPR\DP.SYS -i:01 -w:00 -p:310

[COMMON]
REM What follows here is the "general" section, containing drivers etc. that should always be loaded.

autoexec.bat

goto %config%

:ONEDRIVE
REM ///FAST Multimedia AG (C) 1995
CALL C:\VMSTUDIO\DPR\DIGITAL.BAT
goto END

:TWODRIVES
REM ///FAST Multimedia AG (C) 1995
CALL C:\VMSTUDIO\DPR\DIGITAL.BAT
goto END

:NODPR
REM Only VM will be initialized.
REM Switch to drive where VM-Studio is installed and switch to the VM-Studio directory.
C:



CD \VMSTUDIO\DPR
REM Init VM with the appropriate port address.
vminit -i:300
goto END

:END
REM The entries here are the options you always want to be loaded.
doskey /insert
keyb gr
SET PATH=C:\VMSTUDIO;%PATH%

Background:

Solution:

Comments:
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FAST VMPC Technote
Fading in 4 Clips Simultaneously
31.10.96

Description/ Symptoms:

You want to create a sequence in VM-Plus in which four video clips are shown on screen at the same time whereby each clip fills one
quarter of the screen.

Use the following steps to produce this effect:

Select the Generic DVE and double-click the effect. This opens the DVE Editor.
Enter the following parameters in the lower right-hand box (OUTPUT WINDOW, Transition Out):
Left: 10; Top: 288; Right: 394; Bottom: 566;

Move the blue box into the lower left-hand corner in the lower left-hand box (OUTPUT WINDOW, Transition In).

Save your changes and quit the DVE Editor.

Place a longer clip onto the V1 track together with the effect you have just edited. In the "Preview", the clip should move into a quarter of
the picture starting from the lower left-hand corner.

Place a second clip of somewhat shorter duration into V2 shortly behind the first effect, lining it up with the last clip in V1. Add a Generic
DVE to V2 and edit the effect as follows:

Lower right-hand box:
Left: 10; Top: 10; Right: 394; Bottom: 288;
Lower left-hand box:
Blue box in the upper left-hand corner.

Save your changes and quit the DVE Editor.

The second clip should appear in the upper left-hand quarter of the picture.

Both effects have yet to be combined (click both effects while pressing Strg/Ctrl, choose the LINK option from the EDIT menu).

Select the range of clips and initiate the option Render Render Selected Range.

Once the clip has been rendered, replace both of the clips in the timeline with the rendered clip. Delete the original effects. Return to the
beginning with a hard cut to V1. Add another clip to V2, placing it near the beginning of the clip in V1, lining it up with the end of the clip.
Add a Generic DVE to V2 and edit the effect as follows:

Lower right-hand box:
Left: 374; Top: 288; Right: 758; Bottom: 566;
Lower left-hand box:
Blue box in the lower right-hand corner.

Save your changes and quit the DVE Editor.

The third clip should appear in the lower right-hand corner of the picture.

Select the range of clips and initiate the option Render Render Selected Range.

Once the clip has been rendered, replace both of the clips in the timeline with the rendered clip. Delete the original effects. Add another
clip to V2, placing it near the beginning of the clip in V1, lining it up with the end of the clip. Add a Generic DVE to V2 and edit the effect
as follows:

Lower right-hand box:
Left: 374; Top: 10; Right: 758; Bottom: 288;
Lower left-hand box:
Blue box in the upper right-hand corner.



Save your changes and quit the DVE Editor.

Now when you run the "Preview", all four clips are shown on screen at the same time.

Another helpful hint: Black edges may appear in picture-in-picture effects. These can be "cropped" off. To do so, use the following
procedure:
Double-click the picture-in-picture effect to open the DVE Editor. Enable the "Border" option (lower left) and click "Settings". This opens
the "DVE Border Settings" dialog box. Enter the width and height (e.g. width: 10, and height: 5) and enable "Transparency", setting it to
100% (this is the decisive factor!).

Background:

Solution:

Comments:
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FAST VMPC Technote
Interesting facts about the FAST Hardlock Twin
14.10.96

Description/ Symptoms:

I - Hardlock Twin

1. Hardlock cannot be found on the parallel port

1.1. "Difficult" interfaces

Problems may occur when the Hardlock is queried at weak interfaces, particularly when a cable or another dongle is located in front of
the Hardlock. We are also familiar with "non-transparent" dongles (Sentinel Pro) from Rainbow. In this and similar cases, the Sentinel Pro
should be plugged in behind the Hardlock.

Some PCs will not initialize the interface until it has been used once to print. In this case, the PC does not recognize the parallel port and
thus the Hardlock until after the printing process. This peculiarity occurs frequently with Notebooks and Green PCs and can always be
disabled.

In contrast to the serial interface, the parallel interface (Centronix) does not have a defined output voltage. This is why we cannot solve
problems regarding the port power. In this case, the only option is to replace or add an another parallel port.

1.2. EEP/ECP Mode

Check whether the printer port has been set to ECP mode. On the hardware side, this "Enhanced Capability Mode" is available in most
new I/O controllers and enabled via the PC BIOS. In addition to a hardware handshake when data is exchanged with the connected
device, this mode also uses a small FIFO memory for the data to be released. This should result in a higher communications rate at the
parallel port.

Use of modules of all types, including the Hardlock dongle, results in a communications error since the control sequence "get stuck" in
the FIFO memory and the software protection module does not support the handshake mechanism.

The Hardlock API Version 3.25 and higher (August 95) can run ECP mode automatically if so instructed and returns the port to
"Compatible Mode", i.e. the standard mode for Hardlock querying. However, please note: no errors will occur provided the data
exchange on this port is not interrupted via ECP (loss of data in FIFO)!

The automatic initiation of ECP mode is enabled via the HL_SEARCH environment variables:
SET HL_SEARCH=278e,378e,3BCe

Since customers in most cases will not use the ECP mode, the BIOS can be used to deactivate the mode.

2. The Hardlock is supposed to be found at the serial interface

As of Hardlock API Version 3.50, environment variables can be used to access the serial port addresses. Entry of the search order is the
only way of addressing the Hardlock II Twin Protection on the serial interface.

SET HL_SEARCH=2f8s

The Hardlock is sought at the local serial interface with the address 0x2f8.

3. Search order and environment variable HL_SEARCH in the Hardlock API

The syntax of the environment variables is:
HL_SEARCH=[Port],...,[Protocol],...,[]
The following parameters are allowed:
[Port] is made up of the I/O address in hexadecimal and a port answerback ID:
378p,278p,3BCp
| |
| |------- Port answerback: p = parallel
| s = serial
| e = ECP
| n = NEC (Japan)
| c = Compaq Contura DockingBase (MUX buggy!)



 

| i = IBM PS/2 special handling
|--------- Interface address

Samples:
----------
SET HL_SEARCH=378p
The Hardlock is only sought at the local printer interface with the
address 0x378.

SET HL_SEARCH=378p,278p,3BCp,IPX,NETBIOS
This corresponds to the automatic search order when the environmental variable is not set. This entry is thus redundant.

Entering "i" solves access problems caused by the reprogramming of the control register of the parallel port by certain drivers (graphics,
printers) under Windows. Hardlock is not detected under Windows (3.x, 95, NT) (or after Windows has been restarted). Since it is
generally difficult to reset the control register, this behavior can now also be enabled by entering the environment variables (e.g. SET
HL_SEARCH=378i)!

The multiplexer of a Compaq Contura DockingBase (for switching between the parallel port and an Ethernet adapter) is reset to the
parallel port to query the Hardlock (e.g. SET HL_SEARCH=378c).

4. Can Hardlock destroy the parallel interface?

No! The Hardlock E-Y-E is a passive module with TTL logic (without internal power supply). Since Hardlock only toggles the BUSY line
during communication, the parallel port cannot be destroyed.

II - Hardlock Drivers

Drivers for Windows 95

In Windows 95, the Virtual Device Driver HARDLOCK VxD gives the user access to the Hardlock without interference on the part of
Windows. HARDLOCK VxD is simply copied into the Win95 system directory. No other entries are required in the system files.

Background:

Solution:

Comments:

Disclaimer:
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FAST VMPC\DPR Technote
VMPC\DPR: XSHIFT and YSHIFT
20.09.96

Description/ Symptoms:

After you have rendered a graphic or a video clip, you notice a disturbing horizontal or vertical shift in the video picture in comparison to
the original image.

Background:

Video Machine uses a so-called video memory controller that has been modified several times over the course of the last years. This
means that there are different versions of the controller. We have discovered that these different versions react differently during the
rendering process. In some cases, it may be necessary to specify SHIFT parameters. The software cannot adapt automatically to the
different VMC (video memory controller) versions since the software is not able to detect the different VMC versions. For this reason, it
may be necessary to adjust the XSHIFT or YSHIFT parameters manually. How this is done is described in the following section.

Solution:

The XSHIFT and YSHIFT parameters are defined in the [DPR] section of the VM.INI file. XSHIFT controls the horizontal shift of the video
picture, YSHIFT the vertical shift. In order to "measure" the horizontal shift (if it is present at all), proceed as follows:

1. Create a graphic consisting of vertical bars and name the file v-bar.bmp, for example.

2. Load the graphic in a "Graphic Group" in VMStudio PLUS! and assign a "Duration" of 5 sec. to the graphic.

3. Put the v-bar.bmp file into the Timeline and save the movie as v-bar.mov.

4. Use the function "Render Movie" to render the movie.

5. Drag the rendered clip within the Timeline until it is parallel to the v-bar.bmp graphic. Add a "split fade" as illustrated in the following
figure:

Use the following procedure to create a "split fade":
Start with a hard cut that you will modify in the DVE Editor. Reduce the size of the blue rectangle in the "INPUT WINDOW Transition IN"
window until it has the values Left=0, Top=288, Right=767, Bottom=575. Repeat this step for the other blue rectangles. Then save the
effect.

Now, when the movie is played, both video tracks will be displayed at one time when the cursor (playline) in the Timeline reaches and
passes over the "split fade". This gives you the opportunity of checking whether a shift occurred during the rendering process.



If a shift has occurred, a line must be added to the VM.INI file. Open the Windows 95 Explorer (VM-Studio does not have to be
terminated first!) and look for the file VM.INI in the "Windows Directory". Double-click the file to open it.
Look for the line [DPR] and add the following line immediately thereafter
XSHIFT=N
in which case N stands for the number of pixels by which the picture of the rendered clip is to be shifted. Negative values shift the picture
to the left, positive values to the right. 0 is also an option!
Save the file, close it, and return to the VM-Studio environment. For the new XSHIFT to take effect, the DPR must be initialized again,
meaning "DPR Reset" must be invoked. To do so, proceed to Device Setup (in the submenu of the TOOLS menu), chose the VM Digital
Player and then click the "Setup..." button. This calls the Digital Player Setup containing the "Reset DPR" button. Click the button.

Repeat steps 3 to 6 until you have found the right parameter.

The YSHIFT parameter is corrected in the same way as the XSHIFT parameter, with the difference that horizontal bars are used and that
the split fade divides the picture in the vertical and not in the horizontal.
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FAST VMPC Technote
Creating a WaterRipple effect with VM-Studio PLUS
17.09.96

Description/ Symptoms:

Use the following steps to create a WaterRipple effect. All instructions are optional. You can make changes at any time to produce your own
personalized effect.

In this example, we use only two clips. For best results, use digitized clips in which only 1 field has been digitized. If you use 2 fields, the output might
be "jittery".

Place both clips into the Timeline, one in V1 and the other in V2 (see Fig. 1). The FX used between V1 and V2 is a Next step is to put both clips on the
timeline, one clip on V1 and the other one on V2 as in figure 1. The FX used between V1 and V2 is a dissolve.

Figure 1.

Select the dissolve only. It must be rendered. After rendering, you need to cut clip 1 and clip 2 precisely at the beginning and end points of the
dissolve. Toggle clip 2 to V1 and place the rendered clip on V2 between clip 1 and clip (see Fig. 2).

Figure 2.

So far so good. We will now go on to create the ripple. By double clicking the rendered clip (clip 3) while pressing the SHIFT key, you open the "Video
Filter" menu. Select 'Punch'. Use the option menu that opens to modify the filter settings. The 'Start' value should be changed to 1 and the 'End' value
should be 100. Select OK and add the 'Ripple' filter. Use the option menu to change the direction to 'From Center' and the frequency to 'High'. The
'Start' value should be 1 and the 'End' value should be e.g. 300. Press OK twice. The color should change to red, meaning that the clip has not yet
been rendered.
You now need to create a Video Machine DVE that produces a 'zoom in' for e.g. 75%. The DVE should resemble figure 3.

Figure 3.



 

After saving your work, the Timeline should resemble figure 4.

Figure 4.

Select clip 2 only. Choose 'Render selected range' from the 'Render' menu. After rendering, delete clip 3 and the 'zoom in' FX from the Timeline. Place
the new rendered clip, clip 4, into V2. Place a dissolve into the FX track approximately 5 frames before the beginning of clip 4 and another dissolve of
about 5 frames at the end of clip 4. By double clicking clip 4 while pressing the SHIFT key, you will open the "Video Filter" menu again. Select 'Motion
Blur'. The Options menu should have the following settings: 'Light Source' = Camera, 'Start': 'Length' should be set to 2 with 'Angle' set to 0, 'End':
'Length' should be 20 with 'Angle' set to 0. Click 'OK' twice. Your Timeline should resemble figure 5.



Figure 5.

Select 'Render selected range' from the Render menu. Replace clip 4 with the new rendered clip, clip 5. Replace the dissolves with a standard
hard-cut. Your WaterRipple is finished and the Timeline should resemble Figure 6.

Figure 6.

Technote created by Rob Tilburg/ 19.08.96

Background:

Solution:

Comments:
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FAST VMPC Technote
How to create a fade to/from a certain color
24.10.97

Description/ Symptoms:

You want to generate a fade to/from white (or the color of your choice) or a special color effect.

Background:

Solution:

1. The following paragraph describes how to create a fade to white (or the color of your choice):

Create a new DVE group (or use a DVE group you have already created).Then open the DVE Editor. Set the "Fade Level" to 0% for
"DVE-In%" and to 100% for "DVE-Out%"; click "BkGr Color" and select white (or the color of your choice).

Do not change the size of the input windows in the "Effect" boxes; instead, resize the output windows, reducing them until they are no
larger than a small dot, centered in the displayed area (the blue area is no longer visible). Set the duration of the dissolve to the desired
value. Give the effect a name and save it. Remember that this effect must be assigned to the video channel opposite the one where the
video clip you want fade to white will be inserted.

Play the effect... and it works!! Why? Setting the fade-in to 0%, the fade-out to 100%, and the background color to white is obvious. Most
problems occurred when customers tried to create this effect themselves.

In fact, if you fail to reduce the output windows to a mere dot on screen, you will see a normal fade to black when you run the effect. The
output windows must be reduced since this is the only way the video signal you want fade to white will disappear, leaving the white
background to fade-in. Otherwise, the video signal will disappear, but what will be left is just black since the signal itself is always covers
the background.

2. The following paragraph describes how to create a fade from white (or the color of your choice):

The procedure is the same as the one used to create a fade to white with the difference that the Fade Level is set to 100% for DVE-In%
and to 0% for DVE-Out%.

3. The following paragraph describes how to create a color effect:

This is a special effect that superimposes a transparent color on a black-and-white live video. This is something anyone can do with
VM-Titler and any other graphics program; but it does, however, require a video channel and time to load the file. You can achieve this
with a custom effect.

Proceed as follows:

Create a new "DVE Group" (or use a custom DVE group that you have already created). Call the"DVE Editor". Set the "Fade Level" to
0% for "DVE-In%" and to 50% for "DVE-Out%" (the final value represents the level of transparency of the superimposed color). Click
"BkGr Color" and select the color you want to superimpose; select the video channel opposite the one where you will put the video signal
(V2 if you are going to insert the clip into V1). Again, leave the input windows at their default values and reduce the output windows to a
dot centered on screen. Enter a duration. Save the effect. Create another new effect: click the "Grayscale" button and save it. Give it the
same duration you set for the first effect.

Now, split the FX Track to double mode; assume you want to apply this color effect to a clip in channel 1. Put the first effect you created
into FX track 2, and the second into FX track 1, directly above the first one. Link the effects. That's all there is to it! The second effect
converts the video clip to B&W; the first effect adds the background color to the clip with the transparency level set in Fade Out%. This is
why the output windows must be reduced to a dot: if you want to see the background color, there must be no foreground signal.

Comments:
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FAST VMPC Technote
Video Cabling with VM-Studio 3.0 and Cable Splitter
28.05.96

Description/ Symptoms:

No video out when a video source is connected to In2 at the cable splitter.

Background:

Because VM-Studio supports Alladin Mediaprinter, the input is always routed to framestore 1 when working in the Project Manager.
Since In1 and In2 cannot be cross-routed (or cross-switched) when the cable splitter is used, a video source connected to In2 cannot be
routed to the output.

Solution:

Use In3, In4, In5, In6

Comments:

n.a.
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FAST VMPC\DPR Technote
Overlay Animation
25.01.96

Description/ Symptoms:

You want to record a single-frame animation consisting of frames containing an alpha channel (e.g. 32-bit *.tga graphics produced in
Photoshop) with a digital DPR clip in the background.

Background:

In Video Machine, the DPR cannot be defined as both player and recorder at the same time. The Timeline cannot be used to record an
animation containing alpha information together with a video signal. In order to be able to produce an overlay animation, an Animation
Background Rack must be used: New Graphics Group -> Load Graphics -> Create Animation Background Rack.

Solution:

The DPR clip to be run in the background of the animation is placed into the Animation Background Rack. Only one Animation
Background Rack should be opened per project.
The animation is then recorded using the functions in the DPR pop-up menu (Build Single-Frame Animation) in the Graphics Group. At
the same time, the DPR clip is played in from the background rack.
If the Background Rack contains several clips, the last clip enabled in the window will be used for the background.
To produce a high-quality overlay animation, choose the lowest compression rate possible. The background clip should also have been
compressed at a particularly low rate. As the overlay animation is created, the background clip is decompressed and then compressed a
second time. This means that it is "played" and then re-recorded. The clip is thus a second generation digital clip, which should not be a
problem at lower compression rates, but will have a doubly negative effect on image quality at high rates.
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n. a.
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FAST VMPC\DPR Technote
Framegrabbing with the DPR
04.01.96

Description/ Symptoms:

You are using digitized clips or animations and want to save one single frame from one or the other as a graphic.

Background:

Solution:

There are several ways of doing so:

1) Play the clip in a loop and save the frame:
- Place the desired clip into the Timeline.
- Open the Clip Editor by double-clicking the clip in the Timeline. Click the Swiss army knife symbol in the Clip Editor and choose
"Ping Pong Play" or "Loop Play". Make sure that you don't accidentally close the Clip Editor! Choosing one of the two options will
cause the clip to be played continuously.
- Create a Graphics Group, choose "New Graphic" and click the camera icon.
- Enter the file name of your choice in the "Grab Image As" dialog box and select a graphic format. Choose In1, 3 or 5 as the VM
Input if you have placed the clip into V1, or choose In 2, 4, or 6 if you have put it into V2. If your setup includes the YUV
Component Interface, you have the option of using the YUV inputs.
- The frame is captured and stored as soon as you press the "Click" button.

2) Split Clip to Images
- The Group containing the desired Clip must be designated for use with the DPR ("Switch to DPR").
- Choose the commmand "New Clip" and select the desired clip.
- Set the Mark In at the desired position and enter one frame (00:00:00:01) in the "Duration" field. Quit the Clip Editor with "Use"
and "Exit".
- Now choose "Split Clip to Images..." from the menu of the Reel Group.
- Enter the file name of your choice in the "Grab Video Frame As" dialog box and then click "OK".

3) Save frame from framestore:
- Place the desired clip into the Timeline into V1 (V2)
- If you shorten (extend) the length of the clip (drag&drop), the last frame of the clip will appear on the monitor. This frame is also
contained in the Video Machine framestore V1 (V2).
- Create a new Graphics Group.
- Use "New Graphic..." to open the Graphic Editor and click the camera icon.
- Set the VM Input to V1 (V2) in the "Grab Image As" dialog box, enter the file name of your choice and select the graphics format.
Press "Click" to save the frame.

Comments:

n. a.
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FAST VMPC Technote
Copying/Generating VM VITC
17.08.95

Description/ Symptoms:

A recorded tape without VITC is to be copied using Video Machine. VM VITC is to be copied onto the master by Video Machine.

Background:

Video Machine converts the incoming analog video signal into a digital signal that is processed on board and then output again as an
analog signal. Video Machine is able to insert VM VITC into the vertical blanking interval of the video signal. In this way, by making a
copy with Video Machine, it is possible to generate VITC on tape material without VITC.

Solution:

Proceed as follows to copy a recorded tape without VITC onto another tape and stripe the tape with VM VITC:
1. Conduct a First Edit on your master tape and interrupt/cancel the edit after at least two minutes have expired.
2. Switch to Assemble mode.
3. Define a clip for the player in Clip Editor. The Mark-In should be set at least 15 seconds into the tape to provide for pre-roll time.
Set the Mark-Out or the Duration according to the length/duration of the material to be transferred.
4. Drag the clip into the Timeline and begin recording by pressing the Record button in the Timeline.

NOTE:
If your tapes are already striped with VITC and you want to transfer the timecode with the copy, cable the player and recorder directly to
each other and make a 1 to 1 copy.

Comments:

n. a.
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FAST VMPC\DPR Technote
DPR-Audio: A-Z
25.08.95

Description/ Symptoms:

1. Dip Switches on the Audio Board

On the bottom of the DPR audio board, you will find a small, red switch panel (see picture) with four dip switches. These switches are
used for setting the input impedance for the four audio inputs of the DPR. The four switches are labeled 1 to 4. These numbers
correspond to the four audio inputs of the DPR. If a switch is in the OFF position (down position), the input impedance of the
corresponding audio channel is set to high impedance. High-impedance audio signals usually come from unbalanced audio sources such
as CD players and cassette recorders.
If any device which supplies low-impedance audio signals (such as professional video recorders with symmetrical audio outputs) is
connected to a DPR audio input, you must set the appropriate switch to ON (activates an input resistance of 600 ohms).

Tips for Setting the Dip Switches

The dip switches are somewhat hidden behind the Wide SCSI socket. If you have trouble accessing the switches, remove the audio
board from the DPR motherboard. To do so, first remove the plastic screw (see picture) and then the audio board by gently pulling it
upwards.

When replacing the audio board, be sure it is seated securely and do not forget to replace the plastic screw.

Generally, you should use a pointed non-conductive object to set the dip switches. However, if the audio board has been removed from
the DPR motherboard, you can probably even set the switches with your fingernail.

As mentioned above, it is somewhat difficult to set the switches when the audio board is connected to the motherboard. Depending on
the type of computer being used and other boards installed (such as a YUV Option), it may even be impossible to access the switches. In



this case, you must set the switches before installing the board. If you are not sure what type of audio source you will be using, you can
set, for example, two inputs to low impedance and two to high impedance.

2. Cables

Important:
The 3-pin 6.3 mm jack on the DPR cable splitter is a balanced mono audio connection. You may not connect a stereo jack. Please refer
to the following illustrations, which show (1) how NOT to cable up the
DPR audio and then some examples of possible cabling.

a) Balanced mono input and output
When using a balanced audio source (e.g. professional video equipment) with XLR jacks/sockets, use a cable with the following pins
(see illustration):

b) Unbalanced mono input and output
When using an unbalanced audio source (e.g. VHS VTR with stereo phono sockets) the 2-pin jack, which leads to the DPR must be
pinned out as shown below.
However, if you use a 6.3 mm 3-pin jack, you must short-circuit screen and ring.

c) Connection of an unbalanced stereo audio source
When using an unbalanced stereo audio source (e.g., CD player with a 3.5 mm stereo jack), the audio signal has to be split between two
DPR inputs. The following illustration is an example using a mini CD player and an adapter going from a 3.5 stereo jack (RCA mini) to
two phono sockets. From the phono socket onwards, use the cabling described under b).



 
3. Cabling

We recommend the following audio cabling for the DPR:

Player Audio Out --> SC-Box or Cable Splitter Audio IN. Set the corresponding audio inputs in "Device Setup".
SC-Box or Cable Splitter Audio OUT --> DPR Audio IN 1,2.
Dip switches 1,2 should be set to the ON position on the audio board of the DPR.

DPR Audio OUT 1,2 --> Recorder AUDIO IN
Headphones or loudspeakers can be connected to the audio output of the recorder.

Check in "General Preferences" whether the option "DPR Audio PB / EE " is active.
If you want to digitize audio from a CD player, DPR Audio In 3,4 can be used for the external audio source. Please note that most
external audio sources like CD players have high-impedance audio outputs. Thus, the dip switches 3,4 on the DPR audio board should
be set to the OFF position.
This method of cabling enables you to work in a strictly analog (linear) mode - as if you didn't have a DPR at all - and can also be used
for digital (non-linear) purposes, if you edit video and audio non-linear.
This cabling can also be used for "hybrid editing" with e.g. analog video signals (linear) and digital audio signals (non-linear) from the
hard disk of the DPR.
You even have the option of mixing analog and digital audio. This is useful for analog editing of video and audio and adding digital audio
from digital audio tracks.
4. WAVE Files

You can use WAVE files with the DPR. First you have to copy the WAVE files from your system hard disk (DOS) to the DPR hard disks.
Note that the DPR only supports 16-bit mono WAVE files. Do the following:
- Open VM-Studio.
- Start the DPR Manager.
- Create a directory on your DPR hard disk and name it accordingly (e.g. wavaudio).
- Now you can drag & drop the WAVE file from your system hard disk to the newly created directory (wavaudio). You can also highlight
several files and copy them simultaneously.
- Drag the directory icon in the DPR Manager onto the blue VM icon in the lower right corner once all files have been copied into the
directory (wavaudio). This icon indicates that VM-Studio has been opened. Now, with the simple drag & drop procedure, directories can
be imported from DPR hard disks (= Reels). If you were to switch to VM-Studio, you would find a reel with the reel ID "wavaudio" and the



corresponding icons of your copied WAVE files.

You can also copy DPR audio files from the DPR hard disk onto your system hard disk. Open the DPR Manager and drag & drop the
relevant audio files onto the system hard disk. The reel you copy the audio files from must not be active in VM-Studio. Reels (=
directories on DPR hard disks), that are currently used in VM-Studio, are highlighted blue in the DPR Manager.
Audio DPR files are divided into two files: an index file (file extension .!Ax) and a data file (file extension .#Ax). These files should be on
your system hard disk. Copy the file and replace the extension .#Ax with .wav or simply rename the file to create a WAVE file with the
extension .wav.

5. Clips with different sampling rates

With the DPR hardware you can play back and mix 8 digital audio track simultaneously. All audio clips, however, must have been
recorded at the same sampling rate. Begin by defining a sampling rate to be maintained throughout the entire project before you digitize
audio. We recommend a sampling rate of 41.1 kHz or 48 kHz. Only these rates ensure that video and audio are synced. If audio files with
different sampling rates are to be used within the same project, use the "wavconv.exe" software to convert them to the same rate.

6. Wavconv.exe

This small but powerful utility allows you to convert and copy audio as well as WAVE files. It comes with the VM-Studio software for DPR.
The file is stored in the directory \VMSTUDIO\DPR.
If you enter "wavconv" at the DOS prompt without any parameters, instructions of how to use the program appear on screen.

WAVCONV WAVE Converter (incl. DPR support) (c) ///FAST Multimedia AG

Syntax: WAVCONV src1 src2 dst1 dst2 Hz bits stereo interpol
src1 ...: mono or stereo file (source file 1)
src2 ...: mono file or '-' if no file (source file 2)
(src1 and src2 can be *.wav or*.#Ax files on a DOS hard disk or *.!Ax files on a DPR hard disk )
dst1 ...: dest file1 (target file1)
dst2 ...: dest file2 or '-' if no file (target file2)
(dst1 and dst2 can be *.WAV files on a DOS hard disk or *.!Ax files on a DPR hard disk)
Hz .....: Sampling rate of the target file (possible values for DPR: 9600/22050/44100/48000 )
bits ...: target file bits (8 or 16) (possible value for DPR: 16)
stereo .: target file mono (0) or stereo (1) (possible value for DPR: 0)
interpol: Interpolation or filter on (1) or off (0)
Examples:
A 22050 Hz, 8bit, mono files is converted and copied onto a DPR hard disk:
WAVCONV chord.wav - d:chord.!a1 - 48000 16 0 1

Stereo files are converted, split and copied on a DPR hard disk:
WAVCONV stereo.wav - d:stereo_L.!a1 d:stereo_R.!a2 48000 16 0 1

Files are converted, merged and copied from DPR hard disk onto DOS hard disk (stereo file)
WAVCONV d:stereo_L.!a1 d:stereo_R.!a2 stereo.wav - 48000 16 1 1

A stereo WAVE file is converted and split in mono files
WAVCONV stereo.wav - stereo_L.wav stereo_R.wav 44100 16 0 1

7. Miscellaneous

You may have encountered a message box with the title "Audio PLL Lock" before digitizing or playing a clip with audio. This box appears
when the DPR tries to synchronize the video frequency with the audio frequency by the means of a so-called PLL switch. In this case, do
NOT click "Cancel" since troublefree audio editing can thus not be guaranteed. Use either 44.1 kHz or 48 kHz as sampling frequency.
Avoid to have clips with different sampling frequencies in your movie or project, because everytime you change the sampling frequency
the PLL has to lock again.

Do not position two successive audio clips on the same digital audio tracks in the Timeline. If you were to attempt to do so, the DPR
would not perform continuous play but rather stop and restart.

Background:

Solution:

Comments:



n. a.
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FAST VMPC\DPR Technote
DPR: Managing and Deleting DPR Clips
17.08.95

Description/ Symptoms:

You want to execute the command "Destroy unused DPR data" and avoid losing data accidentally.

Background:

A DPR reel in a project corresponds to a directory on the DPR hard disks. If you give the same name to reels (reels with the same
reel-ID) in different projects, the command "Destroy unused DPR data" may result in a loss of data since all information will be deleted
that is not in use in the current (opened) project. The command cannot differentiate whether the deleted data is used in another project.

Solution:

Don't use the same ID for two reels. We recommend using a reel-ID derived from the name of the project. For example, the first four
letters refer to the project, the last four to the reel: proj_001, proj_002, etc.

Comments:

Digital Player Recorder manual: Tutorial: 2.2 Deleting Digital Image and Audio; Video Machine User Guide: Tutorial: 4. Managing your
raw footage using the Project Manager; Video Machine Reference: Project Manager: 3.2 Group.

Disclaimer:
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FAST VMPC Technote
Interference in clip picons
18.06.98

Description/ Symptoms:

You have installed VM and discover that the picture is full of noisy interference or is completely white or black when defining
clips or grabbing graphics.

Background:

There is a video frame buffer on VM whose contents are transferred either in whole or in part to the memory of your computer (RAM).
This is necessary in order to ensure fast access to the video data if it is to be displayed on the VGA monitor as it would be when defining
clips (picons) or grabbing graphics.
The video frame store can be inserted in different RAM sectors. There are two options:
- in the blocks over 1 MB (linear addressing)
- in what is known as the "UMB sector" (EMS addressing). These are the memory blocks from 640 kByte to 1 MB. Blocks in the range of
D000 to E000 can be used, in which case, one 64 kByte block is required, i.e. VM uses the block of memory from D000 to DFFF, or the
area from E000 to EFFF.

DOS will not allow you to reserve memory blocks for an application. In conjunction with VM and a memory base of D000 or E000, this
means that other programs (DOS drivers) or HW (e.g. controllers) may also use the memory area allocated to VM. If this is the case, you
may encounter memory conflicts that are noticeable as noise or a completely white picture in the picon or graphics.
Should you run into a hardware conflict, it will not be enough to block the sector in the Config.sys file (EMM386.EXE X=&) since the
hardware may have already been using the memory blocks.

Solution:

Since most systems are now configured under Windows 95, the configuration described below is based on the Windows 95 operating
system.
In modern Plug&Play systems, VM will only require use of the memory blocks D000-DFFF and E000-EFFF. The blocks in D000 is the
preferred sector.

In order to ensure that these blocks are not already being used by other components in the system, check, and if necessary, change, the
following parameters:
In your system's BIOS (in this case, we are basing the scenario on an AWARD BIOS) in the PnP and PCI Setup, use the entry ISA MEM
BLOCK BASE on the right hand side. The range should be defined as D000. Once you have changed the entry, the line ISA MEM
BLOCK SIZE should appear. Enter the size of the block as 64K.
By making these changes, the memory block D000-DFFF will be reserved for an ISA component, for example, VM. If your computer
won't start after you've made these changes, it may be that your motherboard cannot be used with VM (e.g. due to on-board SCSI
controller).

The next step is to check whether any other components make any claims on these memory blocks. One way of checking in Windows 95
is
> Settings > Control Panel > System > Device Manager > Computer > Properties > Memory. This box will list occupied memory blocks.
No entries should appear in the D000-DFFF sector.

You can also use this Windows box to reserve memory blocks. To do so, click Reserve Resources > Memory > Add and enter a start
value of D000 and an end value of DFFF. This is a good test to determine whether any other components have staked their claims on
this memory area. Windows would issue an error message, if this was the case, or the entry will read: Not available for use by devices.

Unfortunately, there are some components that use this memory block, but which will not be displayed by Windows. The most frequent
"felon" in this case is the Adaptec SCSI controller 2940.
If you're using this controller in your system, after reserving the blocks in BIOS, you will need to make the following modification. The
controller needs to be moved to another vacant PCI slot in your PC or removed completely from your computer for the time it takes to
restart it. Once you have made the modification, you can assign new blocks to the controller via the bus. It should no longer occupy the
D000-DFFF sector because of the BIOS reservation.

When reinstalling VM-Studio, choose the value D000 from the option box in Custom Setup. Then click TEST MEMORY and follow the
dialog.

As a rule, the settings suggested here for BIOS and under Windows are by no means the same, suitable, or possible for all systems (e.g.
Iwill PII NS). However, in most cases, they should be correct.

Comments:
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FAST VMPC Technote
DP/R: RAM Upgrade
07.08.97

Description/ Symptoms:

The standard version of the Single DP/R has a 6MB RAM onboard. The Double DP/R has 10MB onboard. Both boards have 4MB for
video channel A and 2MB for audio in the form of standard SIMMs on the main board. The piggyback board of the Double DPR has a
fix-mounted 4MB RAM and cannot be upgraded. Any upgrades are limited to the main board and are thus identical for both the Single
and the Double DP/Rs.

The 6MB on the board are, as described above, divided among two banks for audio, which are closer to the end of the board, and four
for video near the middle of the board. The SIMM banks can be upgraded with all standard, commercial SIMM modules (30-pin, 8 or 9
bit, min. 70ns). At the moment, we recommend an upgrade of video channel A to 16MB. The audio store must and should only be
upgraded if it is clear from the beginning that you will be using all eight audio tracks frequently and two-stream video. Moreover, the
SIMMs used for audio and video A must be identical.

To help you understand this whole procedure better, we'd like to give you a short explanation of how the store on the DP/R works. You
can basically think of the store as a pre-read cache. If a video sequence is called from VM, the DP/R more or less reads ahead and loads
the data into the onboard store. During normal operation, when only one video stream is read from the disk, this reading ahead isn't an
issue. It becomes interesting if you want to insert a transition (an effect of longer duration with two moving video streams). During a
transition, the DP/R must be provided with double the data transfer rate from the disks. If the disks are not able to supply this data rate,
you wind up with so-called "dropped frames": the picture jitters. In this case, one of the data streams is read into the cache on the DP/R.
If you then insert a transition, the one stream with the full data rate comes directly from the cache and the second stream from the hard
disk. This gives you jitter-free transitions whose total data rate would actually be too high otherwise.

RAM Upgrade for DPR HW Revision 1.6

A new HW revision 1.6 has been available for the DPR since early 1997. The most obvious feature of the new DPR is the PS 2 Simm
module. As it has recently become increasingly difficult to procure standard RAM Simms, FAST has been forced to change the layout of
the DPR to accommodate PS2 Simms.

For all practical purposes, we have determined that it is not necessary to upgrade the audio RAM. Video A can be upgraded to a
maximum of 16 MB with standard PS2 RAM modules (min. 70 ns, NO EDO RAM, with or without parity, both possilbe).
Please be aware of the fact that even if you should try and use PS2 Simms with more than 16 MB, only 16 MB will be recognized.

The DPR thus uses the following memory components:

Video A (upgradable, PS2, min. 70 ns, NO EDO RAM, with or without parity, both possible)
Video B (soldered into place)
Audio (soldered into place)

One last thing: An upgrade makes sense as a way of "handling" high data transfers for short periods of time as may occur during A/B roll,



for example. It would be better, however, to use the VM-PLUS software since it is able to generate long A/B rolls (picture-in-picture) by
rendering. This is just one of the advantages of the VM-PLUS software.

Background:

Solution:

Comments:

Disclaimer:
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FAST VMPC\DPR Technote
DP/R: Use of a Live Player
17.08.95

Description/ Symptoms:

You want to to dub in extra music, for example, from an audio CD player.

Background:

Video Machine does not support CD player control. However, you can digitize information from this live source and produce an Audio
Clip.

Solution:

1. Connect your live source to the audio inputs of Video Machine, and VM Audio Out to DP/R.

2. Begin by installing the VM Live Player in Device Setup. To do so, select the MCI1 port, for example, as the interface. Define None as
the video input. Specify the appropiate audio inputs in the device setup.

3. Choose New Reel to switch to the Clip Editor. You can set the length of the music title by clicking MARK IN/OUT in New Clip as you
usually would. The default setting for MARK IN is 01:00:00:00. Enter the required length in MARK OUT by typing in the new values, or
type in the desired duration directly and save your entry with USE. If you define more than one clip, make sure to use different values for
MARK IN/OUT.

4. To dub in the audio signal, you can adjust the levels of the digital audio input under Tools and choose the channels (A1/A2/A3/A4) to
be used as the source.

5. Choose Digitize Objects to digitize the data. You will have to start the CD player manually after the time bar has been displayed on the
PC monitor. The audio file appears in the Reel window as a gray icon in the shape of a musical note.

6. Make sure to use Switch to DPR to enable the DPR. This step must be completed before the Audio Clip can be placed into the digital
audio track in the Timeline.

Comments:

n. a.

Disclaimer:
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FAST VMPC\DPR Technote
DP/R: Importing WAVE Files
17.08.95

Description/ Symptoms:

You want to be able to use WAVE files (e.g., STEREO) created by a sound card as the background music for your film project.

Background:

The DPR only supports 16-bit mono WAVE files that are placed on one digital audio track. You have a choice of 9.6, 22.05, 37.8, 44.1
and 48 kHz as the sampling rate setting. Existing STEREO files, however, must be broken down into two MONO files with the
appropriate software, for example, Samplitude Pro, before they can be imported: left.WAV, right.WAV, for example. When the files are
then imported via the DPR Manager, both MONO files will always be allocated to the left channel, designated by the extension ...!a1.
Thus, the files must be renamed in the DPR Manager: Name.!a1, Name.!a2. In this case,

Name.!a1 is the left channel
and Name.!a2 is the right channel.

Solution:

1. Create an analog clip and then digitize it. Close the Reel, and save the Project. The important thing here is that you have an existing
DPR Reel.

2. Close VM-Studio. You will not be able to copy files with the DPR Manager as long as the relevant Project and the Reel to which you
want to move the WAVE file are loaded.

3. From the DPR Manager, the WAVE file can now be copied into the Reel just opened on the DPR hard disks (drag and drop onto the
yellow Reel).

4. After using Switch to DPR to switch into the saved Reel, open the window Select Clip of Reel by double-clicking the gray area of the
pane. OK will transfer files that physically exist into the Reel.

5. Click USE in the Clip Editor to save the WAVE file. It will be displayed as a gray icon in the REEL window.

6. The WAVE files can be used like any DPR Audio Clip.

Comments:

n.a.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.





 

FAST VMPC Technote
PAL/NTSC Conversion with Video Machine
17.08.95

Description/ Symptoms:

Video Machine can also be used as a standard converter. This means that existing television standards (PAL or NTSC) can be converted
into another standard..

Background:

The most important standard conversion is probably into and out of PAL-BG and NTSC and vice versa. Wheres the problem?

PAL has a resolution of 768x576 pixels at a frequency of 50 Hz (25 frames per second), an NTSC signal, however, has a resolution of
640x480 pixels at a frequency of 60 Hz (30 frames per second). And, simply converting isnt enough to transform one type of signal into
another:

· In converting from NTSC to PAL, the NTSC output signal is scaled up to a size of 768x576 pixels and 5 fps are thrown out.
· In converting from PAL to NTSC, the PAL output signal is reduced to a size of 640x480 pixels and 5 fps are doubled.

Of course, it depends on the content of the video material itself how visible these conversion effects actually are. By adding and doubling
frames, jittering and flickering may occur when objects in the image move rapidly back and forth.

Another important factor in converting video signals is using the right VCR. If you want to convert to another standard, you must use an
original NTSC or PAL VCR (depending...).

Some PAL VCRs (for example, FS -200 or FS-90) can play NTSC tapes. The resulting video signal, however, is not a true NTSC signal.
Video Machine cannot process this fake video signal.

Solution:

The following points should be followed to use Video Machine as a standard converter:

· Choose the correct input signal in Encoder (PAL or NTSC),
· Choose the correct output signal in Output Setup,
· Create a clip the same length as the video to be converted,
· Choose the conversion effect under Special Effect (PAL -> NTSC or NTSC -> PAL).
· Use the effect as the cross-fade effect for the video to be converted.
· Record the resulting film.

Comments:

Video Machine User Guide: VM-Studio\Setups\Output Setup
VM-Studio\Setups\Encoder Setup

Disclaimer:
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FAST VMPC Technote
Video Machine and the ATI Ultra Pro Graphics Card
17.08.95

Description/ Symptoms:

1. Video Machine is already installed and the ATI Ultra Pro graphics card is added to your system. After having installed the ATI Ultra Pro
and the MACH32 driver, the VM-Studio software can no longer be started correctly.

2. The ATI Ultra Pro graphics card is already installed in your system and Video Machine is added to it. After installing Video Machine,
the VM-Studio software cannot be started correctly.

Background:

Video Machine and the ATI Ultra Pro graphics card use an identical port address and memory mapping. This results in a conflict between
the two boards when this graphics card is used with Video Machine. Since Video Machine can be configured via the software, you can
eliminate the problem by the following new configuration of the system:

Solution:

1. Switch Windows to normal VGA mode for the duration of the new installation. To do so, specify the standard VGA driver under the
Windows Setup program instead of MACH32.
2. Start VM-Studio.
3. Select the "Tools" menu from the tool bar and choose the "Hardware Setup" menu item.
4. Now specify a Port Address that is not occupied by the ATI Ultra Pro graphics card (this board generally uses the 300 port address) or
by any other board. Try port address 120, for example.
5. Switch from Memory Mapping to EMS (e.g., E000 or D000). This configuration should prevent any conflicts between Video Machine
and the ATI Ultra Pro graphics card.
6. You can now use the Windows Setup to re-install the MACH32 driver optimized for ATI Ultra Pro. Both boards should now function
properly.

Comments:

Video Machine Manual: Installation\Hardware Setup

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.
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FAST VMPC Technote
VITC on the Master Video Recorder
17.08.95

Description/ Symptoms:

You want to be able to read the VITC from your master tape.
Your master tape has been corrrectly precoded and/or and or picture information with VITC is already recorded on the tape.

Background:

As with the players, Video Machine provides the recorder with direct support of VITC (Vertical Integrated Timecode).
Thus, Video Machine does not require that VITC be transmitted via the control interface. VITC is part of the video signal and is broadcast in the
blanking interval. The video signal of the recorder must be fed into Video Machine again so that the VITC of the recorder can be detected.

Solution:

1. Connect the cables of your recording device's video output to one of Video Machine's free video inputs.
(Note: please use inputs Video Input 3 to Video Input 6 since Video Machine has freely scaleable cross bars at these inputs.)
2. Specify the chosen Video Input for the Master VITC in Device Setup. For example, if you connect the master video output to Video
Input 5, a video input must be specified in Device Setup for the master recorder. In this case, logically, Video Input In 5.
3. Choose DEVICE SETUP from the TOOLS menue. There you have to choose the SETUP. The next window comes up by pressing the
VM TC button. Enable the "Use VM VITC when TC board missing" option. If you do not know the exact value of the "Constant Shift", you
must disable the "Use constant shift instead of autocalibrate" option, even if the drivers select it as the standard option. (Open the
General Player Setup via the Tools button in the Device Setup)
4. Enable "VITC" in Output Setup.

If a tape recorded with VITC or 1st Edit is played in the master video recorder, the VITC indicator will light up in green in REC Control.

Comments:

Video Machine User Guide: VM-Studio Setups\Device Setup
VM-Studio Setups\Output Setup

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
Audio Dub with Consumer Recorders
17.08.95

Description/ Symptoms:

After you have edited and recorded your video and the original sound as the first step, you now want to go on to the next editing step, the
recording of "external sound", for example, dubbing in background music from a CD. To avoid generation losses, you will want to record
the external sound onto the completed master tape (postsynchronization, audio dub).

Background:

The audio recording on VHS/S-VHS tapes is on two tracks:

- the vertical track that is inserted directly into the video picture (frame scanning gap) and which can be used for high-quality hifi
recordings

- and the parallel or longitudinal track that are only used for lower quality mono or stereo recordings due the small amount of information
recorded. (This does not apply to professional recorders.)

The vertical track is integrated in the video picture during recording. High-quality hifi signals can only be recorded together with the video
signals. It is not possible to re-record onto the vertical track.
Video recorders like the NV-FS200 that have so-called audio dub or postsynchronization capabilities are only able to postedit the audio
longitudinal track.
Devices only capable of recording the hifi track have no audio dub capabilities.

Solution:

1. Re-record the desired audio sequences onto the hifi track of a clean
VHS/S-VHS tape.
2. Connect the hifi socket of your player to one of the free audio inputs on
Video Machine.
3. Connect the audio output on Video Machine to the longitudinal track
input (usually CH2) of your recorder and insert your master tape into the recorder.
4. Switch to assemble mode in "Output Setup".
5. Disable video track V and the hifi track A2 in "REC Control".
6. Use the Timeline to define the clips for the audio tape and start recording.

Comments:

Video Machine User Guide: VM-Studio\REC Control

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
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LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.
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FAST VMPC Technote
Simultaneous Playback of Roll/Crawl Titles and Effects
17.08.95

Description/ Symptoms:

You want to insert a roll or crawl title through an effect (e.g., tumbles, shrinks or moves). The resulting video image is faulty (jumps, no
transparency, etc).

Background:

If Video Machine creates a roll/crawl title the title is - in figurative terms - pushed through the frame store. During this time, Video
Machine uses the non-visible, lower part of the image to continue loading text and graphics information. If an effect is now applied this
part can become visible. This can cause unwanted side effects in the display of the title.
It is also not possible to combine roll and crawl titles with alpha effects (matrix, pattern, rotation and special alpha) since Video Machine
uses the alpha channel of V1 and V2 to create alpha effects. Thus, no alpha channel is available for transparent titles.

Solution:

Use a hardcut or a dissolve to insert roll and crawl titles.

Comments:

Video Machine User Guide: VM-Studio\The Titler
VM-Technote No. 013

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
Two Simultaneous Roll & Crawl Titles
17.08.95

Description/ Symptoms:

You place roll and crawl titles parallel on both channels. They are displayed in preview without any problems. During playback on the
timeline the overlapping titles are not displayed properly.

Background:

During playback roll and crawl titles have to be calculated in real time. However, present PC processors do not have sufficient processing
power to calculate two titles simultaneously. Thus, you may not have overlapping titles on the timeline.

Solution:

Use only one roll or crawl title at one time.

Comments:

Video Machine User Guide: VM-Studio\Titler
VM-Technote No. 014

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.
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FAST VMPC Technote
Timing with Alpha Wipes
17.08.95

Description/ Symptoms:

You place effects from the Alpha Wipe Library (matrix, pattern, rotation and special alpha wipes) on the timeline. Playback is faulty.

Background:

During editing all alpha wipes on the timeline are prepared by the computer. This process is a relatively complex calculation which
requires processor capacities. The average computer needs at least two seconds to prepare an alpha wipe.

Solution:

Allow the computer time to calculate the alpha wipes. Set the interval between alpha wipes on the timeline to at least two seconds.

Comments:

Video Machine User Guide: VM-Studio\Objects\Editing in the Timeline
VM-Studio\Titler
VM-Technotes No. 013, 014

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.
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FAST VMPC Technote
Titles with MS WinWord
17.08.95

Description/ Symptoms:

You want to assign a title to your video using the software MS WinWord. You have selected "Build one Page" in the VM Title Driver.
During preview you notice that the last part of the title, i.e. the lower margin of your WinWord document, has been "cut off".

Background:

For the layout of your title Video Machine uses the parameters specified in the WinWord page setup. The title is "cut off" because these
settings do not correspond to the size of a video image.

Solution:

Adjust the page setup to the video standard using the following values:

VM-Titler: Build one Page

MS WinWord:

PAL: Page Setup: (Margins)
Top: 0 cm
Bottom: 0 cm
Page Setup: (Size and Alignment)
Width: 20,32 cm (8 inch) == 768 (96 dpi)
Height: 15,24 cm (6 inch) == 576 (96 dpi)

NTSC: Page Setup: (Margins)
Top: 0 cm
Bottom: 0 cm
Page Setup: (Size and Alignment)
Width: 16,93 cm (6.66 inch) == 640 (96 dpi)
Height: 12,70 cm (5 inch) == 480 (96 dpi)

Hint: If you often use WinWord to create titles and want to avoid having to change parameters every time, you can make the appropriate
style sheets (*.dot). Thus, you can save time and get the right parameters just with a mouse click.

Comments:

MS WinWord Manual: "Page Setup"; "Style Sheets"

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.
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FAST VMPC Technote
Vertical Image Shift
17.08.95

Description/ Symptoms:

When operating Sony Betacam equipment with Video Machine the looped video image from the Betacam (the monitor is connected to
Recorder Output/Monitor Out) is vertically shifted.

Background:

Vertical image shifts occur on the Betacam´s monitor output if the Betacam and Video Machine are not synchronized.

Solution:

Video Machine and the Betacam must be synchronized. Connect Composite Out on Video Machine to Ref-In on the Betacam.

Comments:

Video Machine User Guide: Installation\Video Connections
Installation\Cable Splitter\Reference Signal
Installation\Studio Control Box\Reference Signal

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.
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FAST VMPC Technote
Image Dropout during Fast Shuttle Operation
17.08.95

Description/ Symptoms:

During fast shuttle operation the video image disappears from the master monitor.

Background:

High shuttle speeds disrupt the "sync" of the video signal. If the sync is missing or badly disrupted Video Machine cannot process the
video signal and switches the output to "black".

Solution:

If the shuttle speed is reduced slightly the video image reappears.

Comments:

n. a.

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
8-Field Sequence with PAL
17.08.95

Description/ Symptoms:

You notice flashing (false color image) at the editing points of the master tape.

Background:

False color images are the result of the 8-field sequence occurring with the PAL standard. Flashing at the editing points is an indication
that the particular edit has not been carried out according to the 8-field sequence. From a technical point of view, a conflict between the
phase of the color carrier (F) and the horizontal phase (H) when linking different video scenes through electronic editing results in
synchronization errors which in turn lead to flickering of the image and false color images. With normal television, these discrepancies
are usually not visible; however, with sensitive studio monitors they are very apparent.
A great advantage of Video Machine is that, as an edit control unit, it supports 8-field sequence editing. However, this places high
demands on your player and recorder.

Solution:

In order for Video Machine to support 8-field sequence editing, the following conditions must be met.

Video Machine either has to be able to genlock to the color carrier phase of the recorder (to do this, the recorder must be able to switch
directly from play to record; most consumer recorders do not have this capability), or

the recorder must be frame-accurate and the player and recorder must be equipped with a capstan bump (again, most consumer
recorders are not equipped with this) and you must precode the tape with an 8-field sequence timecode (Video Machine supports this
type of precoding in its first edit function).

Comments:

Karl-Heinz Trissl/Arthur Heller in the "Rundfunktechnische Mitteilung" (publication for radio
engineering) 1984, Issue 3

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.
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FAST VMPC Technote
Timecode Error
24.10.97

Description/ Symptoms:

When working with a source tape that was not recorded in a single shot, the video unit winds to the wrong position.

Background/Explanation:

Information regarding position on the source tape (timecode or CTL) is not continuous.
This may be due to the fact that you recorded scenes on different days. Since your camera bases the timecode information on its
integrated clock, although two scenes may be recorded directly next to each other on the tape, their timecodes may be completely
different.
In order to stabilize the drive of the player, Video Machine performs a "preroll", i.e. it winds to a position on the tape in front of the
Mark-IN.
If, during the preroll, the video recorder is wound to an area with a completely different timecode, it can no longer find the editing point.

Example:

Scene 1 VITC 00:10:00:00 Scene 2 VITC 00:00:01:24

Timecode Leap

This also applies to recordings with gaps between individual scenes. These gaps result in noise and snow in the picture and cause the
tape counter of the video unit (camera or recorder) to temporarily stop advancing.

Solution:

Be sure that the clip you wish to edit is within an area with a continuous timecode or CTL. This prevents the player from winding beyond
a timecode leap during a preroll and not being able to find the Mark-IN .

You can only avoid such timecode errors through better organization when recording source tapes. It is especially important to code an
area of the tape before each new sequence (for example, by recording for 20 seconds with a closed lens).

Background:

Solution:

Comments:

VM-Technote No. 003

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED



THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
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FAST VMPC Technote
Preroll Times
24.10.97

Description/ Symptoms:

You have no problems controlling video players or recorders in the clip editor. However, errors occur once you have positioned a clip on
the timeline and it begins to play back (for example, the unit winds the tape to the beginning or end and doesn't move at all).

Background:

As an edit control unit, Video Machine uses the time code on the video tape to control video players and recorders. Video Machine can
handle a variety of time codes: CTL, VITC, RAPID, RCTC and LTC.
In order to stabilize the drives of the player and recorder, Video Machine performs a "preroll", i.e. it winds to a position on the tape in front
of Mark-IN or Cut-IN.
The problem mentioned above occurs when you have defined the Mark-IN of the player or the Cut-IN of the recorder at the very
beginning of the coded area of the tape. In attempting to perform a preroll for editing, the video unit is wound to an area of the tape which
doesn't have a time code or the system searches for an area on the tape which does not exist (beyond the beginning or end of the tape).
In either case, the edit control unit (Video Machine) loses its point of reference for positioning.

Solution:

First, create a precoded area of tape before each Mark-IN of the video player and before the first editing point of the recorder. With
professional equipment, this is usually done by recording the set of color bars for 1 minute. Video Machine also provides the First Edit
function for doing this. With camcorders, you can do this by recording with a closed lens for 1 minute (black recording).
Be sure to take into account the preroll times of Output Setup of VM-Studio. Define the first editing point on the timeline by using the Start
Recording function. Allow at least 1 minute for the preroll. For example, if you began precoding at 00:01:00:00, the starting value of the
timeline should be set at 00:02:00:00. This prevents the system from cueing to an uncoded or non-existent position on the tape.

Comments:

Video Machine User Guide: VM-Studio\Setups\Output Setups Features
VM-Technote No. 004

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
A/X Roll
17.08.95

Description/ Symptoms:

You wish to mix two scenes, i.e. link them with an effect or transition. However, both scenes are either on the same source tape or you
only have one player (A/X roll) and you don't want to jeopardize quality by making a copy.

Background:

Generally, only hardcuts are possible between scenes on the same input tape. However, Video Machine supports the A/X roll mode
which permits effective transitions when playing in two clips from the same tape/player.
To do this, Video Machine "freezes" the last image of the first clip in the video memory. The system then switches from this still image to
the second clip with the effect selected (such as cross-fading).

Solution:

Be sure to only use In 3,4 (S-Video) and In 5,6 (FBAS) as inputs since these are linked via crossbars.
For further instructions (for example, on placing clips on the timeline), please refer to the appropriate sections in your manual (see
below).

Comments:

Video Machine User Guide: Installation\A/X-Roll Setup
VM-Studio\Timeline\A/X-Roll Operation
VM-Studio\Timeline\Video Tracks

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.

© Copyright FAST Multimedia AG. All rights reserved.



 

FAST VMPC Technote
Black Frames in Insert Mode
17.08.95

Description/ Symptoms:

When editing with Video Machine in insert mode, one or more black frames appear between video images recorded earlier and those
subsequently inserted.

Background:

The insert mode is used for subsequently inserting individual scenes into videos recorded earlier. Top-of-the-line consumer equipment
supports this mode; however, its support is limited (see below). The insert mode is often used for assemble editing, i.e. video clips are
recorded one after the other on a blackburst tape.
To use the insert mode, both the edit control unit (Video Machine) and the recorder must be frame accurate. Precisely this is the root of
our problem: while Video Machine is frame accurate, due to their mechanical properties, consumer recorders usually are not.
The figure below illustrates the problem. For example, due to a recorder's inaccuracy in positioning a frame, the frame is not precisely
inserted at cut-in (X), but rather one frame too late (A).
As a result, you still see black frames of the precoded tape. On the other hand, if a frame is inserted before cut-In (B), this usually goes
unnoticed since no black frames are visible.

Solution:

When positioning clips on the timeline, insert the new clip one frame earlier in the previously recorded clip.
To do so, switch off the magnet. Then, move the clip one frame to the left with the mouse or the < Ctrl> + <> key combination.

Comments:

Video Machine User Guide: VM-Studio\Output Setup
VM-Studio\Timeline\New Positioning of Clips
VM-Studio\Timeline\Editing Styles

Disclaimer:

FAST'S SUPPORT SERVICE AND THE INFORMATION CONTAINED IN THIS DATABASE OR TECHNOTE IS PROVIDED "AS-IS"
SOLELY FOR THE PERSONAL AND PRIVATE USE OF FAST'S CUSTOMERS. FAST MAKES NO WARRANTY, WHETHER
EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE) CONCERNING THIS DATABASE, ANY TECHNOTE, OR THE INFORMATION CONTAINED
THEREIN. EACH CUSTOMER'S SITUATION AND OPERATING ENVIRONMENT IS DIFFERENT, AND FAST DOES NOT
GUARANTEE THAT THE INFORMATION PROVIDED WILL BE EFFECTIVE. FAST IS NOT RESPONSIBLE FOR ANY ERRORS OR
OMISSIONS IN THIS DATABASE OR IN ANY TECHNOTE, THE CONTENT OF WHICH IS SUBJECT TO CHANGE WITHOUT
NOTICE. THE USER OF THE INFORMATION PROVIDED IN THIS DATABASE OR TECHNOTE ASSUMES ALL RISKS
CONCERNING ITS ACCURACY AND USE.

ALL WARRANTIES AND OTHER LIMITATIONS OF LIABILITY CONTINUE TO BE GOVERNED BY THE LICENSE AGREEMENT AND
WARRANTY CONTAINED IN YOUR ORIGINAL FAST PRODUCT. NO PORTION OF THIS KNOWLEDGEBASE OR TECHNOTE MAY
BE COPIED, REPRODUCED OR DISTRIBUTED WITHOUT THE EXPRESS WRITTEN CONSENT OF FAST, EXCEPT THAT
CUSTOMERS OF FAST MAY PRINT A COPY OF THIS KNOWLEDGEBASE OR TECHNOTE FOR THEIR OWN PERSONAL USE SO
LONG AS ALL COPYRIGHT NOTICES AND THIS DISCLAIMER IS REPRODUCED ON SUCH COPY.
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